InertiaCube3™ and the InertiaCube Processor

Product Manual for use with
InertiaCube3 and the InertiaCube Processor

© 2012 InterSense, LLC / A Division of GENTEX Corporation
700 Technology Park Drive
Suite 102
Billerica, MA 01821
Phone +1 781.541.6330 • Fax +1 781.541.6329
www.intersense.com
Contacting InterSense

Please do not hesitate to contact us for any reason. We are here to help and we value your business.

© 2012 InterSense, LLC / A Division of GENTEX Corporation
700 Technology Park Drive, Suite 102
Billerica, MA  01821
Phone +1 781.541.6330 • Fax +1 781.541.6329
USA

Telephone:   (781) 541 6330   email:  ISinfo@intersense.com
Fax:   (781) 541 6329   Internet:  www.intersense.com
Technical Support:   (781) 541 7624   email:  techsupport@intersense.com

Patents

The label below identifies the protection granted by the Government of the United States to InterSense for its products:

U.S. Patents
5,645,077; 5,807,284; 6,162,191;
6,176,837; 6,314,055; 6,361,507;
6,409,687; 6,474,159; 6,681,629;
6,757,068; 6,786,877; 6,922,632;
7,000,469; and Patents Pending.

Trademarks

InterSense™, InertiaCube™, InertiaCube3™ SoniDisc™, GEOSTM, PULSARTM, CONSTELLATION™ are trademarks of InterSense, LLC. All other trademarks are the property of their respective owners.

Copyright © 2012

InterSense, LLC
Precautionary Statements

Any changes or modifications to the InertiaCube3 not expressly approved by InterSense, LLC or Gentex Corporation will void the warranty and any regulatory compliance issued for the system.

Do not drop or otherwise shock the tracking devices for they can be permanently damaged.

Do not bend, twist, pull strongly or tamper in any way with any part of the cabling.

Take care to avoid electric shocks. Do not plug-in or unplug the power cable with wet hands.

Do not mount InertiaCube3 with steel or other ferrous metal fasteners and do not use a magnetic tipped or ferrous metal screwdriver when mounting the InertiaCube3. Use only non-ferrous fasteners and tools around the InertiaCube3. FAILURE TO FOLLOW THIS PROCEDURE WILL VOID WARRANTY AND MAY REQUIRE FACTORY RECALABRATION OF SENSOR.

Please see Appendix C for Health and Safety warnings and guidelines.
# TABLE OF CONTENTS

## 1 SYSTEM DESCRIPTION

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>InertiaCube3 Integrated Inertial Instrument</td>
<td>6</td>
</tr>
<tr>
<td>1.2</td>
<td>InertiaCube3 Components</td>
<td>8</td>
</tr>
</tbody>
</table>

## 2 SPECIFICATIONS AND PERFORMANCE CHARACTERISTICS

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1</td>
<td>Performance Specifications</td>
<td>10</td>
</tr>
<tr>
<td>2.2</td>
<td>Optional USB Adapter Specifications</td>
<td>11</td>
</tr>
<tr>
<td>2.3</td>
<td>Optional InertiaCube3 Processor</td>
<td>11</td>
</tr>
<tr>
<td>2.4</td>
<td>3-DOF Gyroscopic Earth-stabilized Orientation Sensing (GEOS™) Algorithms</td>
<td>12</td>
</tr>
</tbody>
</table>

## 3 HARDWARE AND SOFTWARE SET-UP OF THE INERTIACUBE3

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>Connection Scheme to Host Computer</td>
<td>14</td>
</tr>
<tr>
<td>3.2</td>
<td>InertiaCube3 Operating System Compatibility</td>
<td>15</td>
</tr>
<tr>
<td>3.3</td>
<td>Windows Software Installation</td>
<td>16</td>
</tr>
<tr>
<td>3.4</td>
<td>Connection Scheme to the Optional InertiaCube3 Processor</td>
<td>16</td>
</tr>
<tr>
<td>3.5</td>
<td>Software Configuration of the InertiaCube3 Processor</td>
<td>17</td>
</tr>
<tr>
<td>3.5.1</td>
<td>Connecting the IC3 Processor to an RS-232 Serial Interface</td>
<td>18</td>
</tr>
<tr>
<td>3.5.2</td>
<td>Configuring the IC3 Processor with ISDEMO</td>
<td>18</td>
</tr>
<tr>
<td>3.5.3</td>
<td>IC3 Processor Mode Switch</td>
<td>19</td>
</tr>
<tr>
<td>3.5.4</td>
<td>Using GENLOCK with the IC3 Processor for Sync or Power Saving</td>
<td>19</td>
</tr>
<tr>
<td>3.5.5</td>
<td>Configuration of the IC3 Processor Ethernet Interface</td>
<td>19</td>
</tr>
<tr>
<td>3.5.6</td>
<td>Set-up and Use of the IC3 Processor Ethernet Interface</td>
<td>20</td>
</tr>
<tr>
<td>3.6</td>
<td>InertiaCube3 Placement</td>
<td>23</td>
</tr>
</tbody>
</table>

## 4 ISDEMO: TESTING THE INERTIACUBE3

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1</td>
<td>Using ISDEMO</td>
<td>26</td>
</tr>
<tr>
<td>4.2</td>
<td>ISDEMO: Main Window</td>
<td>27</td>
</tr>
<tr>
<td>4.3</td>
<td>File Options</td>
<td>28</td>
</tr>
<tr>
<td>4.3.1</td>
<td>File Menu for IC3 Processor</td>
<td>29</td>
</tr>
<tr>
<td>4.4</td>
<td>Communications Options</td>
<td>30</td>
</tr>
<tr>
<td>4.4.1</td>
<td>Communications Menu for the IC3 Processor</td>
<td>31</td>
</tr>
<tr>
<td>4.5</td>
<td>Parameters Options</td>
<td>33</td>
</tr>
<tr>
<td>4.5.1</td>
<td>Parameters Menu for the IC3 Processor</td>
<td>36</td>
</tr>
<tr>
<td>4.6</td>
<td>Display Options</td>
<td>37</td>
</tr>
<tr>
<td>4.6.1</td>
<td>Display Options for the IC3 Processor</td>
<td>38</td>
</tr>
<tr>
<td>4.7</td>
<td>Tools Options</td>
<td>39</td>
</tr>
<tr>
<td>4.7.1</td>
<td>Tools Options for the IC3 Processor</td>
<td>43</td>
</tr>
<tr>
<td>4.8</td>
<td>Compass Calibration Tool</td>
<td>46</td>
</tr>
<tr>
<td>4.9</td>
<td>Magnetic Environment Calibration Tool</td>
<td>50</td>
</tr>
<tr>
<td>4.9.1</td>
<td>Theory of Operation</td>
<td>50</td>
</tr>
</tbody>
</table>
1 System Description

Congratulations for buying the smallest, precision orientation tracker on the market! This technology offers you several advantages:

- Very low latency
- Unlimited range
- Smooth, jitter-free tracking
- Low power consumption
- Optional wireless configuration
- Optional dedicated processor

The InertiaCube3 is an inertial 3-DOF (Degree of Freedom) orientation tracking system. It obtains its motion sensing using a miniature solid-state inertial measurement unit, which senses angular rate of rotation, gravity, and earth magnetic field along three perpendicular axes. The angular rates are integrated to obtain the orientation (yaw, pitch, and roll) of the sensor. Gravitometer and compass measurements are used to prevent the accumulation of gyroscopic drift.

1.1 InertiaCube3 Integrated Inertial Instrument

The InertiaCube3 is a monolithic part based on micro-electro-mechanical systems (MEMS) technology involving no spinning wheels that might generate noise, inertial forces, and mechanical failures. The InertiaCube simultaneously measures 9 physical properties, namely angular rates, linear accelerations, and magnetic field components along all 3 axes. Micro-miniature vibrating elements are employed to measure all the angular rate components and linear accelerations, with integral electronics and solid-state magnetometers. The magnetometers are included for optional yaw drift correction in the sourceless inertial orientation mode only. The geometry and composition of these elements are proprietary, but the functional performance of the multi-sensor unit can be understood sufficiently by reference to the equivalent diagram in Figure 1.

Figure 2 illustrates the basic physical principal underlying all Coriolis vibratory gyros. Suppose that the tines of the tuning fork are driven by an electrostatic, electromagnetic, or piezoelectric drive to oscillate in the plane of the fork. When the whole fork is rotated about its axis, the tines will experience a Coriolis force \( F = \omega \times v \) pushing them to vibrate perpendicular to the plane of the fork. The amplitude of this out-of-plane vibration is proportional to the input angular rate, and is sensed by capacitive, inductive, or piezoelectric means to measure the angular rate.

By way of comparison, a conventional inertial measurement unit (IMU) senses 6 of these properties using 6 separate instruments (3 rate gyros and 3 linear accelerometers) each of which by itself would typically be larger, heavier, and more expensive than an InertiaCube. Unlike conventional rate gyro and accelerometer instruments, which must be carefully aligned on a precision machined tri-axial mounting block, the InertiaCube is a monolithic device with its orthogonal outputs factory calibrated to precise alignment. Being a digital device using serial cables, the InertiaCube3 cabling and connectorization is relatively non-critical, and the cables can be extended to over 100 feet without fear of contaminating sensitive analog signals. In addition, a Wireless InertiCube3 is also available from InterSense to eliminate cabling between the sensor and computer. The power consumption of the InertiaCube3 is 40 mA at 6VDC, which makes it
suitable for 8 hour operation from a standard 9 VDC battery in wireless applications. The Wireless InertiaCube3 Supplemental Users Manual covers the set-up and operation of this InertiaCube3 configuration. The photo on the top of the following page shows an InertiaCube3.

---

Figure 1 -- Functional diagram of InertiaCube3

Figure 2 -- Principle of Coriolis vibratory Gyroscope
### 1.2 InertiaCube3 Components

The following parts list shows all components that ship with a standard RS-232 Serial InertiaCube3 under InterSense order number ISC-IC300-A000. Items 8 & 9 below, the InterSense USB to RS-232 Converter and the InertiaCube3 Processor, are *optional* and not included with the standard order.

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Part No.</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. IC3 Serial Sensor Cube w/ 15 ft. cable</td>
<td>100-IMU00-0300</td>
<td>1</td>
</tr>
<tr>
<td>2. Wired IC3 Mounting Plate</td>
<td>083-00104-IC3F</td>
<td>1</td>
</tr>
<tr>
<td>3. 2-56 x ¾ Pan Head Nylon Screws</td>
<td>092-P0256-NP12</td>
<td>3</td>
</tr>
<tr>
<td>4. RS-232 Powered Serial Interface</td>
<td>100-23750-RJ12</td>
<td>1</td>
</tr>
<tr>
<td>5. AC/DC +6VDC Power Supply</td>
<td>066-CUI06-0200</td>
<td>1</td>
</tr>
<tr>
<td>6. AC Power Cable (country specific)</td>
<td>078-2COND-xx06</td>
<td>1</td>
</tr>
<tr>
<td>7. Wired IC3 Product CD</td>
<td>Ver. 3.8x or higher</td>
<td>1</td>
</tr>
<tr>
<td>8. RS-232 to USB Converter</td>
<td>ISC-SCFBR-USB1</td>
<td>Optional</td>
</tr>
<tr>
<td>9. InertiaCube3 Processor</td>
<td>ISC-IC30E-ICP2</td>
<td>Optional</td>
</tr>
</tbody>
</table>
Standard InertiaCube3 Components (mounting screws & Product CD not shown)

Optional USB to RS-232 Serial Converter
## 2 Specifications and Performance Characteristics

### 2.1 Performance Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value/Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Degrees of Freedom</td>
<td>3 (Yaw, Pitch and Roll)</td>
</tr>
<tr>
<td>Angular Range</td>
<td>Full 360° - All Axes</td>
</tr>
<tr>
<td>Maximum Angular Rate*</td>
<td>1200° per second</td>
</tr>
<tr>
<td>Minimum Angular Rate*</td>
<td>0° per second</td>
</tr>
<tr>
<td>RMS Accuracy*</td>
<td>1° in yaw, 0.25° in pitch &amp; roll at 25°C</td>
</tr>
<tr>
<td>RMS Angular Resolution*</td>
<td>0.03°</td>
</tr>
<tr>
<td>Serial Interface Update Rate</td>
<td>180 Hz</td>
</tr>
<tr>
<td>Minimum Latency</td>
<td>2 ms for RS-232 (PC host OS dependent)</td>
</tr>
<tr>
<td>Prediction</td>
<td>up to 50 milliseconds</td>
</tr>
<tr>
<td>Serial Rate</td>
<td>115.2 kbaud</td>
</tr>
<tr>
<td>Interface</td>
<td>RS-232 Serial</td>
</tr>
<tr>
<td>Size (without mounting plate)</td>
<td>1.031 in x 1.544 in x 0.581 in (26.2 mm x 39.2 mm x 14.8 mm)</td>
</tr>
<tr>
<td>Weight</td>
<td>0.6 ounces (17.0 grams)</td>
</tr>
<tr>
<td>Cable Length</td>
<td>15 ft. (4.572 m) - Max. 75 ft (22.86 m)</td>
</tr>
<tr>
<td>Power</td>
<td>6 VDC, 40 milliamps</td>
</tr>
<tr>
<td>Operating Temperature Range</td>
<td>0° to 70° C</td>
</tr>
<tr>
<td>O/S Compatibility</td>
<td>.dll for Windows 98/2k/NT/XP/CE</td>
</tr>
<tr>
<td></td>
<td>.so for Linux and SGI IRIX</td>
</tr>
<tr>
<td></td>
<td>libisense.dylib for Mac OS X</td>
</tr>
<tr>
<td>Software Support</td>
<td>SDK with full InterSense API</td>
</tr>
<tr>
<td></td>
<td>Ethernet via Windows Control Software</td>
</tr>
<tr>
<td></td>
<td>Heading Calibration Software</td>
</tr>
</tbody>
</table>

*Measurements with perceptual enhancement algorithm turned off (= 0)
2.2 **Optional USB Adapter Specifications**

- **InterSense USB Update Rate**: 180 Hz (Windows 98/2000/XP)
  
  180 Hz (Macintosh OS X)

- **USB Interface Minimum Latency**: 2 ms for USB direct (Host & OS dependent)

- **Power Source**: Direct from Host USB Port

- **USB Adapter Size**: 2.36 in x 1.38 in x 0.79 in
  
  (60 mm x 35 mm x 20 mm)

- **Cable Length**: 9.84 feet (3 meters)

2.3 **Optional InertiaCube3 Processor**

- **Number of Trackers Supported**: up to two InertiaCube3 sensors

- **Update Rate**: 180 Hz nominal

- **Supply Voltage**: 6 VDC nominal (5.5 VDC min. – 6.5 VDC max.)

- **Current Draw with one InertiaCube3**: 400 mA typical (320 mA min. – 550 mA max.)

- **Current Draw with two InertiaCube3s**: 440 mA typical (360 mA min. – 590 mA max.)

- **Operating Temperature**: 0˚ to +50˚ C

- **Storage Temperature**: -20˚ to +70˚ C, non-condensing

- **Sensor Interface**: two RS-232 Serial at 115.2 kbaud

- **Host Interface**: Ethernet (TCP or UDP protocol)
  
  RS-232 with only one sensor

- **Size and Weight**: 6.0 x 10.0 x 2.5 cm and 86 grams
2.4 3-DOF Gyroscopic Earth-stabilized Orientation Sensing (GEOS™) algorithms

The flow diagram below shows the processing which is used to compute orientation using this sensor configuration. The basic computation of orientation from gyroscopic angular rates (in the top line of boxes) provides the very rapid dynamic response and high resolution of the system. The accelerometers and magnetometers are used to stabilize the orientation to the earth’s gravitational and magnetic fields, thus eliminating the gradual but unbounded accumulation of gyroscopic drift errors. The Kalman filter uses an ever-evolving adaptive algorithm to discard the portion of the accelerometer measurements, which are due to actual motion instead of gravity. This is a very important step, because otherwise horizontal accelerations would result in very large transient pitch and roll errors known as “slosh”. The low cost sourceless trackers used in early consumer HMDs are inclinometer/compass devices, and are thus intrinsically slosh-prone to the point of being uncomfortable to use.

**GEOS mode tracking algorithm**

In the default operating GEOS mode, the reference frame (hereafter referred to as Navigation frame, Nav frame or N frame) is the locally-level geographic frame with its x-axis pointing north, y-axis east, and z-axis down. The Euler angles reported by the tracker can be described as a sequence of rotations applied to the InertiaCube starting with its body axes initially aligned with the Nav frame axes and resulting in the current orientation. The sequence starts with a rotation by +yaw about the Z axis, followed by a rotation by +pitch about the new Y axis (i.e. body frame axis), followed by a rotation by +roll about the new X axis (i.e. body frame x axis).

The line from the magnetic field sensor outputs of the InertiaCube to the Kalman filter is a dotted line to indicate that the use of the magnetometers may optionally be disabled. The accelerometer measurements are sufficient to correct all the drift in pitch and roll, and the geomagnetic compassing function is only used to correct drift in yaw. In some head mounted display (HMD) applications, absolute yaw referenced to magnetic north is not important and relative yaw tracking is sufficient. This is the case when the user can turn to face an object or rotate the virtual world to bring that object into view. In these situations, it may be desirable to turn magnetic yaw compensation off if there are large variations in the
direction of magnetic north over the tracking area. With the compassing turned off, the yaw value will drift a few degrees per minute. This drift is too slow to notice while it is happening, but the cumulative yaw error may eventually become noticeable if the user is seated in a fixed chair, and then it may be necessary to apply a Heading Boresight. When yaw compensation mode is disabled, the Nav frame axes are aligned instead to pseudo-north, pseudo-east, and down, where pseudo-north is simply the direction the InertiaCube3 x-axis was facing on power-up or after application of a Heading Boresight command. Refer to Section 4.5 to read about the InertiaCube3’s compass settings.

In applications where absolute yaw reference to magnetic north is important, such as location awareness in mobile navigation, the compass setting for the InertiaCube3 must be enabled (turned on). If the InertiaCube3 is mounted in a distorted, though static, magnetic environment (i.e. attached to a ferrous object), and optional, in-situ magnetic calibration can be performed to compensate for static magnetic field distortion. Refer to Section 4.7 to perform a standard heading calibration of the InertiaCube3.
3 Hardware and Software Set-up of the InertiaCube3

NOTE: The InertiaCube3 sensor is a precision instrument. Care must be taken when handling this device. Although the product can withstand the normal wear and tear experienced by a premium HMD or other devices, abrupt actions such as dropping or banging against another object can permanently damage the InertiaCube.

3.1 Connection Scheme to Host Computer

The InertiaCube3 orientation sensor comes with a 15-foot cable that plugs into the RS-232 Serial Interface Connector or the optional RS-232 to USB Converter. The USB to RS-232 converter is supplied with an additional 9 foot cable.

The InertiaCube3 simply plugs into the RS-232 or USB port of a computer. For RS-232 interfacing, the AC to DC power adapter is plugged into your main power and the 6 VDC power plug connects to the RS-232 serial port connector.

Next the AC to DC power converter is connected to wall power and the 6 VDC power jack is plugged into the serial port connector jack.

Finally, the serial port connector is connected to your computer. Up to 32 InertiaCubes can be connected to a PC using standard or virtual COM ports.

For USB interfacing, the InterSense USB to RS-232 serial converter is plugged into the USB port on the host computer. The InterSense USB to RS-232 serial converter will up convert the 5 VDC power from the USB port to a regulated 6 VDC power required by the InertiaCube3. Other third-party USB to RS-232 serial converters will work with the InertiaCube3, but typically require an external power source or main power adaptor.
The InertiaCube3 can interface through the USB port of any computer running an operating system supported by InterSense. When connecting through USB Hubs, which in turn are connected to the host computer, latency will increase by approximately 5 to 8 ms. Latency through the USB interface is also dependent on the operating system used with the computer. Please contact our technical support (techsupport@intersense.com) for questions related to USB latency and operating systems.

For optimum USB performance with the InertiaCube3, we recommend use of the optional InterSense USB to RS-232 Serial Converter. To use, simply plug the RJ12 connector from the InertiaCube3 cable into the USB to RS-232 Converter and then plug the USB connector into the host computer.

Please refer to Appendix B or the Product CD for detailed instructions on installing and the configuration of the USB drivers for the InertiaCube3.

3.2 InertiaCube3 Operating System Compatibility

The InterSense InertiaCube3 is PC compatible with Windows CE, 95, 98, 2000, NT and XP. InterSense libraries that are compatible Linux, SGI IRIX, HP-UX and Mac OS X are also included on the support CD. All third party software using the standard InterSense libraries are also supported. Please check with third party software providers or InterSense (techsupport@intersense.com) about specific software compatibility and support.
3.3 Windows Software Installation

Test software and the InterSense Software Development Kit (SDK) delivered with the InertiaCube3 are provided on the InterSense Support CD with the system. Use the auto install tool to extract and install the software on your Windows PC.

The core of all InterSense software running on a Windows PC is the isense.dll. When installed with the auto installer Product CD, the isense.dll is automatically place in the WINDOWS or WINNT system directory. This library, along with all other InterSense libraries used with other operating systems, provides a standard interface to all InterSense tracking systems.

Isdemo32.exe is installed in the InterSense\Programs folder. It provides a convenient graphical interface for testing and configuring the tracker.

Iserver.exe (the InterSense Server Application) provides multiple services to applications requiring tracker data. IServer runs in the system tray, reading the data from the connected devices at the maximum speed allowed by the operating system. That data is then made available to other applications that use the InterSense DLL to communicate with the tracker. This allows multiple applications running at the same time to read data from the same tracking device.

Joystick Emulation Drivers can present any InterSense tracker as a joystick to the operating system. This provides games, like the Microsoft Flight Simulator, use of the tracker to control the line of sight. IServer reads tracker data in real time and passes it to the InterSense Joystick Driver, where it becomes available to all applications capable of reading joystick through DirectInput Interface.

The JMouse program allows any joystick device to control the "line of sight" in 3D applications, such as games, flight simulators, etc. It works by converting joystick movement to simulated mouse commands. JMouse uses DirectInput to detect and read data from joystick devices, so it requires DirectX version 8.0 or higher. To work with InterSense tracking devices, JMouse requires InterSense Joystick drivers and IServer to be installed and running.

The InterSense SDK sample programs and instructions are also installed from the CD. The SDK folder contains InterSense libraries for Windows, WindowsCE (PocketPC), Linux, HP-UX, SGI IRIX and Mac OS X. Sample code is provided to demonstrate the SDK use in Microsoft Visual C++, Visual Basic, WindowsCE, Linux and IRIX applications.

Please see the documentation on the InterSense Support CD for details.

3.4 Connection Scheme to the Optional InertiaCube3 Processor

The InertiaCube3 Processor (IC3 Processor) is a small, low-power processor for use with the InertiaCube3 orientation sensor. The IC3 Processor is intended for applications that use an InertiaCube3 but lack an external host on which to run InterSense tracking software. The IC3 Processor processes the raw inertial data from the InertiaCube's MEMS sensors and delivers ready-to-use orientation data (yaw, pitch, roll) to the host using the standard InterSense protocol via RS-232 or Ethernet.
The picture below shows a typical connection from a single InertiaCube3 to the IC3 Processor. In this photo, the host interface to the IC3 Processor is the RS-232 serial port. The 6 VDC Power to the IC3 Processor can either come from the RS-232 power jack (shown in the upper right hand corner of the photo) or directly to the IC3 Processor.

InertiaCube3 to InertiaCube3 Processor Connections

If you plan to use the Ethernet host interface to the IC3 Processor, the RS-232 Serial interface (as shown in the photo above) must be used first to set up and establish the Ethernet interface parameters. Details on setting and using the Ethernet interface on the IC3 Processor are found in Section 3.5.5.

3.5 Software Configuration of the InertiaCube3 Processor

The IC3 Processor is equivalent in functionality to an early InterSense product—the IS-300 processor. The IC3 Processor is for use with the InertiaCube3 and is compatible with the standard InterSense libraries (.dll, .so, etc…). The InterSense SDK contains sample C code with which to develop drivers for embedded hosts or platforms not supported by the InterSense libraries.

There are two different ways to interface to the IC3 Processor—RS-232 serial or Ethernet. To use the Ethernet interface, the IC3 Processor must first be configured for Ethernet through the RS-232 Serial interface connected to a Windows PC running ISDEMO software.
3.5.1 Connecting the IC3 Processor to an RS-232 Serial Interface

First plug the InertiaCube3 into Port 2 and connect Port 1 to the Powered RS-232 Serial Interface with the supplied serial crossover cable. The Powered RS-232 Serial Interface then plugs in to the serial port on the host computer (see block diagram below). There are two options for connecting the +6 VDC power supply – either connect the DC power supply to the Powered RS-232 Serial Interface (Option 1) or the power jack on the side of the IC3 Processor housing (Option 2). Plug the included power supply into a wall outlet to supply power to the system. The Power and both Port LEDs on the ICP should both come on.

After about 20 seconds, the IC3 Processor will flash the Port LEDs and then turn each LED off. Subsequently, the Port 2 LED will flash whenever the InertiaCube senses motion. The IC3 Processor is now ready to use.

For initial set-up, it is recommended that the IC3 Processor be connected to a Windows PC host so that it can be easily tested and configured using the ISDEMO utility. To proceed with set-up on a Windows PC, install the software from the supplied CD now and review Section 4 if you are not familiar with using ISDEMO.

3.5.2 Configuring the IC3 Processor with ISDEMO

If using a Windows PC host, the ISDEMO utility can be used to test and configure the IC3 Processor. After installing ISDEMO launch the program and at the opening screen, select IS-300 and then click Accept. Using the Communications pull-down menu, select the COM port the IC3 Processor is connected to on your Windows PC. Then select Display→Start to start the display.

Use ISDEMO to configure the IC3 Processor as needed for your specific application (see Section 4 for description of different configuration settings & filters). Settings can then be saved to non-volatile memory on the IC3 Processor by selecting File→Save in ISDEMO.
3.5.3 **IC3 Processor Mode Switch**

The mode switch is used to upgrade the IC3 Processor firmware, should it be necessary. The switch is covered by a round protective plug on the IC3 Processor housing. There is no need to remove the protective plug or use this switch for any reason other than a processor firmware upgrade. Should an upgrade be needed, InterSense will provide instructions for its use with the upgrade kit.

3.5.4 **Using GENLOCK with the IC3 Processor for Sync or Power Saving**

The IC3 Processor can be synchronized to an external TTL or NTSC signal for optimum tracking performance in applications using a head mounted display. Please contact InterSense for more information about configuring and using the IC3 Processor with an external GENLOCK sync signal.

By default, the IC3 Processor is not set up for low-power operation. To reduce power consumption, use the **Tools**→**Send** option in ISDEMO to send the “MG3,60” command to the system which will turn on internal GENLOCK with a reduced output frame rate. The system will then output records to the host at a maximum of 60 Hz (saving approx. 10% power from the typical setting). The system still runs at 180 Hz internally, so performance is maintained. Power consumption can be further reduced by using the “MG3,91” command, however the internal rate will drop to 90 Hz (saving approx. 20 % power from the typical specification).

To keep these low power settings during power cycles, remember to send the **File**→**Save** command from ISDEMO.

3.5.5 **Configuration of the IC3 Processor Ethernet Interface**

The IC3 Processor has an Ethernet port for host communication with connection of up to two InertiaCube3s. By default, the Ethernet port is disabled and Port 1 is used for RS-232 host communication. To enable the Ethernet interface, first connect the IC3 Processor to your Windows PC, as described in Section 3.5.1.

Next, an IP address must be assigned to the IC3 Processor. After connecting to the IC3 Processor with ISDEMO via the RS-232 host connection, select **Tools**→**Send Command String** and enter the Ethernet enable command, MEthIp, followed by the dotted IP address, (e.g., “MEthIp192.168.1.30”). Then select **File**→**Save** to commit the IP address to non-volatile memory. The Ethernet port is now ready to use.

Port 1 can be used for host communication anytime an InertiaCube3 is not connected to the port.
3.5.6 Set-up and Use of the IC3 Processor Ethernet Interface

Once the IP address is set, as described in Section 3.5.5, use the supplied Ethernet Crossover Cable to connect the IC3 Processor directly to the host computer (Note: when connecting to an Ethernet Hub, a standard Ethernet cable is used—the supplied Crossover cable will not work when connecting to a Hub). Up to two InertiCube3s are next connected to Ports 1 and 2. +6 VDC Power is supplied to the IC3 Processor via the power jack on the same side of the housing as the RS-232-Port 1 connection.

![Ethnernet Host Interface to IC3 Processor with two InertiCube3s](image)

Two Ethernet interface standards are available—a two-way TCP command interface and an output-only UDP broadcast interface. The InterSense library and ISDEMO support both interface standards. Details of using ISDEMO to set-up and communicate to the IC3 Processor via Ethernet are documented in Section 4.

The TCP command interface uses the same InterSense command protocol used for RS-232 host communication. Only a single client at a time can connect via the command interface using socket port 5005.

The TCP command interface can be used simultaneously with the serial host interface. However, the system still has only a single internal state, so settings changed over one interface will affect both equally (except for the continuous mode setting, which is independent for each).

The UDP interface broadcasts system data packets using UDP. The default socket port is 5001 and is configurable via ISDEMO or host application commands to allow more than one system to broadcast over the same network. UDP broadcast is independent of activity on the serial host interface and the TCP command interface. It is also independent of the continuous mode settings, which affect the serial port and TCP command interface only. UDP broadcast always transmits data packets continuously. Like continuous mode, the packet rate is equal to the internal update rate or, if enabled, the GENLOCK rate.
The commands related to Ethernet configuration are listed below. They can be issued via the RS-232 or TCP command interfaces.

MEthIp[address]<>  Sets system IP address. Use dotted format like 192.168.1.30. If address is omitted, the current setting is returned, 31EI[address]<> . The IP address takes effect immediately unless an address was already set, in which case system settings must be saved and the system must be restarted.

MEthUdp[state]<>  Sets state of UDP broadcast: state=1 to enable, state=0 to disable (default). If state is omitted, the current setting is returned, 31EU[state]<>.

MEthUdpPort[port]<>  Sets UDP broadcast port. Default is 5001. If port is omitted, the current setting is returned, 31EUP[port]<>.
3.6 InertiaCube3 placement

Do not mount InertiaCube3 with steel or other ferrous metal fasteners and do not use a magnetic tipped or ferrous metal screwdriver when mounting the InertiaCube3. Use only non-ferrous fasteners and tools around the InertiaCube3. FAILURE TO FOLLOW THIS PROCEDURE WILL VOID WARRENTY AND MAY REQUIRE FACTORY RECALABRATION OF SENSOR.

The InertiaCube is typically screwed or bolted to the object it is tracking (use of plastic or aluminum screws is required to achieve optimal performance). As best as possible, locate the InertiaCube level to the ground in relation to its actual position during use. The photos below show the local coordinate axes and the possible mounting positions for the InertiaCube3.

![Local InertiaCube Coordinate Frame (left) and three possible mounting positions (InertiaCube3 can also be mounted with the logo facing down—not shown above)](image)

Optimally, you would mount the InertiaCube onto a base plate. In cases of anticipated vibration or physical shock, it is recommended that rubber mounting pads be used.

![NOTE: When using the InertiaCube3 with Perceptual Enhancement Level 1 or 2 (see Section 4.5 Parameter Options), do not mount the InertiaCube3 on either side, as this causes instability in the enhancement algorithms which can lead to sensor drift.](image)

If the InertiaCube3 is configured for maximum accuracy with no Perceptual Enhancement (set to Level 0), then side mounting is acceptable.

The InertiaCube3 has two options for mechanically mounting. When using the supplied mounting plate, the hole pattern and size is identical to the InertiaCube2 and IS-300 InertiaCube. This allows you to replace an older InterSense InertiaCube with an InertiaCube3 requiring no modifications to your original mechanical interface.

For low profile and tight mounting constraints, the mounting plate is removed and three #2-56 through screw holes are available to directly mount the InertiaCube3 housing to the object being tracked. Please use the supplied nylon 2-56 x ¾ pan head screws or some other non-ferrous metal fastener to mount the InertiaCube3.
The drawing below shows exact dimensions and mounting locations for the mounting plate and the InertiaCube3 housing.

InertiaCube3 Mechanical Dimensions and Mounting Holes (dimensions in inches)

The InertiaCube3 comes with a 4.572 m (15’) cable attached. This cable plugs into the serial port connector. The range of the InertiaCube is theoretically unlimited and is only restrained by the length of the cable that attaches it to the computer. A length of 4.572 meter (15 feet) is standard on all orders. Extension cables are available. Contact InterSense to order extension cables.

Tracker Use Guidelines

- Keep the InertiaCube(s) still for the first 10 seconds after starting your application software.

InertiaCube3 Manual
Doc. No. 072-00094-0D05 Rev.2.1
• It is recommended, though not required, that you wait for the InertiaCube to warm up (it achieves optimal performance after warming up for at least 15-20 minutes).

• The InertiaCube is tuned for normal head motion in immersive display applications with the perceptual enhancement filter set to 2. Set the perceptual enhancement filter to 1 or 0 for augmented reality or precision tracking applications. See Section 4.5 for details about Perceptual Enhancement Level settings.

• Avoid shaking/vibration of the InertiCube3. Remember, this precision instrument uses angular rate sensors, which sense smooth, regular movement very well.

• If there are magnetic disturbances even after you have followed the mounting recommendations closely, you can compensate for these distortions by using the Dynamic Magnetometer Calibration (see Section 4.7). This magnetic field calibration may be required if during a 90 degree rotation in yaw the sensor reports a turn close to 90 degrees but then settles at a number off by 10 degrees or greater. If the suspected source of the static magnetic field distortion is rigidly attached to the InertiaCube3 (i.e. an HMD or when used in a weapon’s simulator), then Dynamic Magnetometer Calibration may be able to compensate for most of the offset induced by this source.

If the source of error is not attached to the IMU then it can not be removed through calibration (i.e. the InertiaCube3 is worn on the body or head inside of a vehicle). In this type of application, please contact InterSense application engineers (info@intersense.com) for alternative tracking solutions.

If you keep these guidelines in mind, your InertiaCube3 will deliver superb performance.
4 ISDEMO: Testing the InertiaCube3

ISDEMO is included as a test and diagnostics tool. With it you can test all the features of your tracker. At the time of this publication, the latest release of ISDEMO is version 4.1715. Please check with [www.intersense.com/support](http://www.intersense.com/support) to keep your version of ISDEMO up to date.

ISDEMO provides a convenient graphical interface to validate the communication of the InertiaCube3 to the PC and test performance through the standard InterSense DLL. See Section 4, Developers Instructions, to learn how to interface the InertiaCube3 to software applications.

4.1 Using ISDEMO

The first screen you’ll see is the hardware selection window (shown below). The program creates a different interface depending on the tracker model selected. Select the DLL Compatible option.

*Note: You must select DLL Compatible, or ISDEMO will not be able to correctly configure your tracker. If using an IC3 Processor connected via RS-232 or Ethernet to the PC, you may select the IS-300 Series connection option which provides additional configuration controls.*

**DLL Compatible**

DLL compatible trackers include all of InterSense’s tracking systems that use software applications programmed to the InterSense API which call functions through the InterSense DLL. Some InterSense trackers, like the InertiaCube3, are only DLL compatible. *Note: The IC3 Processor can interface either directly through a serial port by selecting IS-300 Series or via the DLL.*
4.2 **ISDEMO: Main Window**

ISDEMO has six primary menus in its main window:

⇒ File
⇒ Communications
⇒ Parameters
⇒ Display
⇒ Tools
⇒ Help
4.3 File Options

When running with the “DLL Compatible” interface, the File menu provides you with the following options:

⇒ Select Hardware Device
⇒ Save Current Settings
⇒ Load Power Up Settings
⇒ Load and Save Factory Settings
⇒ Reset Heading (Ctrl+B)
⇒ Exit (Ctrl+Q)

Select Hardware Device

System Initialization window (also seen at initial start-up) is shown when Select Hardware Device is selected. Use this window to select or detect the tracker model connected to your computer.

Save Current Settings

Saves current settings to a file in the windows directory. The next time the tracker is turned on these settings will be restored.
Load Power Up Settings

Restores the InertiaCube settings to those present when you first powered up the tracker. All changes made to the settings since power up are lost.

Load and Save Factory Settings

This restores the system settings to the factory defaults.

Reset Heading

Resets the current heading to zero. Also known as a heading boresight.

Exit

Closes ISDEMO

4.3.1 File Menu for IC3 Processor

When using the IC3 Processor with the “IS-300 Series” interface, the File menu provides you two different menu items:

⇒ Boresight Current Station   (Ctrl+B)
⇒ Unboresight Current Station  (Ctrl+U)

Boresight Current Station

Resets the current heading to zero. Also known as a heading boresight.

Unboresight Current Station

Removes the heading boresight so sensor will point to true north.
4.4 Communications Options

This menu item will connect the tracker through the DLL. The DLL will automatically detect an InterSense tracker connect to COM ports 1 through 4 on the PC. The baud rate of the InertiaCube3 is fixed at 115,200 baud. Make sure the computers serial port is capable of supporting this baud rate. The first two rates (kbps and records/s) displayed at the bottom of the window show the InertiaCube3 update rates. The third rate (frames/s) shows the graphics update rate based on the PC’s hardware configuration.

**Detect Tracker**
Will reinitialize the DLL and detect the connected tracking device(s).
4.4.1 Communications Menu for the IC3 Processor

When using the IC3 Processor with the “IS-300 Series” interface, the Communications menu changes to allow setup through both RS-232 and Ethernet.

Communications Setup

The IC3 Processor allows both Serial communications as well as Ethernet communications. The Ethernet interface is used as a command interface with exactly the same InterSense command protocol used for the serial port. Either communications interface is available as a view port while the host application is communicating through the other interface. Using ISDEMO on one port while communicating tracking data through the second allows performance of basic diagnostics or system configuration while the host application is live.

Selecting the Communication Setup menu option brings up of the following configuration window. The default settings are Use Serial with COM port 1 at a rate of 115,200 baud.

![Communication Setup Window]

Ethernet Configuration

Ethernet is disabled by default. An IP address must be configured using the serial port to enable the Ethernet option. Refer to Section 3.5.5 to set an IP address for the IC3 Processor. Two Ethernet interface paths are available - a command interface and a UDP broadcast interface. TCP is used in this case with socket port 5005. Only a single client at a time can connect via the command interface.

Server IP Address

Enter the IP address of the IC3 Processor in the Server IP Address box, and leave the Network Port set at 5005. After typing the Server IP Address, you must hit enter while the cursor is still in the box, or the program will ignore the change.
Network Port

The default setting for TCP is 5005. To change the socket port you must configure the IC3 Processor.

Serial Configuration

Default settings are for the serial port set to COM 1 with a baud rate of 115,200.

Serial Port

Choose the RS-232 port the tracker is connected to.

Baud Rate

Choose the communications speed the tracker is connected at. The IC3 Processor only supports 115,200 baud rate.

Connect

ISDEMO attempts to connect to the IC3 Processor using the selected communication parameters.

Cancel

Exits the screen saving the current selected communication parameters.

Detect RS232 Settings

When chosen, this option will automatically detect the port and the baud rate being used. The program attempts to establish communication by sending the $S$ command (status record request) and waiting for a response for 2 seconds. If the status record is not received within that time the program tries again with the different communication parameters.
4.5 Parameters options

Parameters menu gives you access to the tracker configuration controls.

Station and Sensor Parameters

The window shown below allows you to configure the InertiaCube3.

Double clicking on the Station line or clicking the Change button will bring up the Station Configuration window where changes can be made.
Station Configuration window

**Station ON/OFF**

The station is always ON and data records will be sent continuously. The InertiaCube3 can not be turned off.

**Compass**

This controls the state of the compass component of the InertiaCube3. When station is configured for FULL compass mode, the readings produced by the magnetometers inside the InertiaCube are used as absolute reference orientation for yaw. Metallic objects and electronic equipment in close proximity to the InertiaCube can affect the magnetometers. When station is configured for PARTIAL compass mode, magnetometer readings are used to reduce drift and maintain stability, but not as an absolute measurement system. In this mode system is much less susceptible to magnetic interference, but heading drift will accumulate. If compass is OFF, no heading compensation is applied.

**Perceptual Enhancement Level**

In order to provide the best performance for a large range of applications, three levels of perceptual enhancement are available. None of the modes introduce any additional latency.

Mode 0 provides the best accuracy. The inertial tracker uses gyros to measure angular rotation rates for computing the sensor’s orientation. To compensate for the drift, tracker uses accelerometers to measure the actual physical position and orientation of the sensor. That data is then used to compute the necessary correction. In Mode 0 correction adjustments are
made immediately, no jitter reduction algorithms are used. This results in most accurate output (not recommended for head tracking) with lower RMS error. Use this mode for accuracy testing or for any application that requires best accuracy.

Mode 1 provides accuracy similar to that of mode 0, with an addition of a jitter reduction algorithm. This algorithm reduces the accuracy by only a small amount and does not add any latency to the measurements. Mode 1 is recommended for augmented reality applications (i.e. overlaying or mixing both virtual and real objects in a visualization system.)

Mode 2 is recommended for use with HMD or other immersive applications. The drift correction adjustments are made smoothly and only while the sensor is moving, so as to be transparent to the user.

**Sensitivity Level**

Use this setting when Perceptual Enhancement Level is set to 1 or 2. It controls the minimum angular rotation rate picked up by the InertiaCube. Default is level 3. Increasing sensitivity does not increase latency during normal movements. It may, however, result in some small residual movements for a couple of seconds after the sensor has stopped. If your application requires sensitivity greater than the maximum provided by this control, you must use Perceptual Enhancement level 0 or 1 instead.

**Prediction Value**

The InertiaCube3 can predict motion up to 50 ms into the future, which compensates for graphics rendering delays and further contributes to eliminating simulator lag.
4.5.1 Parameters Menu for the IC3 Processor

When using the IC3 Processor with the “IS-300 Series” interface the Parameters menu changes by adding in a Tracker System Parameters menu item.

When Tracker System Parameters is selected, the following panel is displayed.

**Output Mode**

Polled or Continuous. In Polled mode, data records are sent out only in response to a P command.

**Data Format**

ASCII

(F command) Numbers are returned in ASCII format. Each number has 7 ASCII characters: a sign, 3 digits, a decimal point, and 2 more digits.

Binary

(f command) Floats are sent as 4 bytes of IEEE 32-bit floats. This can increase the data throughput by minimizing the size of the record.
4.6 Display Options

Start (and Stop) Displaying Data

To display orientation data being received from the tracker, use the Start Displaying Data option in the Display menu or press Ctrl-D. Use Stop Displaying Data to turn the real-time display off or press Ctrl-X (the data and record rate will still update even if the display is off).
4.6.1 Display Options for the IC3 Processor

When using the IC3 Processor with the “IS-300 Series” interface the Display menu changes by adding in a Current Sensor selection and a Display Text/Sensor menu items.

Current Station

Allows the user to choose which station is to be displayed in the main window of ISDEMO. Ctrl-Fx, where x represents the station number, can also be used to switch stations. For example, to switch to station 2, use Ctrl-F2.

Display Text/Sensor

When this option is selected all status and some of the data records are displayed in text format in the sensor display area. To prevent graphics updates from taking over most of the processor time, no more than 20 data records per second are displayed. Ctrl-T toggles the menu item between showing the text and showing the sensor.

Please note that whenever your tracker is in continuous mode, records are displayed in the text window even when the display is off.
4.7 Tools Options

System Information
This window provides a summary of the InterSense tracker hardware and software configuration.

System Self Test
Its purpose is to detect and display information on all the connected hardware and compare it to the user configuration to
evaluate it for errors. Use this tool to troubleshooting the system when hardware failure is suspected (select Test \(\rightarrow\) Run Tests to acquire test data). Save the test file (select File \(\rightarrow\) Save to a File) and email it to InterSense technical support (techsupport@intersense.com) if there are any questions.

**Error Report**

If the InertiaCube3 reporting errors from the System Self Test, the Error Report (select File \(\rightarrow\) Get from Tracker) will generate information about the errors. Save the error report file (select File \(\rightarrow\) Save to a File) and email it to InterSense technical support (techsupport@intersense.com) if there are any questions.

**Compass Calibration Tool**  (See Section 4.8)

**Data Capture/Playback Utility**
ISDEMO has the ability to write the data it receives from the tracker to a file. To utilize this feature you must first specify the name and location of the output file. To start data collection, select **Record**. Data can be saved as **As Is**, or in an ASCII or binary flat file. When Flat File option is selected, only tracker data is saved, one line per update cycle. To import data to Excel or Matlab the output format must be set to ASCII or the **ASCII Flat file** option must be used. Previously recorded data can be displayed through ISDEMO by selecting **Play**. Playback option will only work on files saved with the **As Is** option.

**UDP Broadcast Server**

This tool is used to broadcast tracker data over the network using UDP packets. Other machines on the network run client software that receives this data.

Client software can only receive data, so stations and output records have to be configured here. Depending on available hardware, select one of the 4 available options for each of the stations:
None

Station is OFF and no data will be received from it.

Generic 6DOF

Only position and orientation data is available. Use this option with the InertiaCube3.

NOTE: A unique Network Port number, not used by any other computer on the network, should be assigned to the server. All client applications, including the ISDEMO, should use that number to receive data. Default is 5001, and should not be changed unless there is a conflict.

UDP Broadcast Client

ISDEMO itself can be a UDP client. Simply enter the port on which data is transmitted and press Receive. As UDP packets are received, data can be displayed in the main window of ISDEMO.
4.7.1 Tools Options for the IC3 Processor

When using the IC3 Processor with the “IS-300 Series” interface the Tools menu changes by adding in a Send Command String, Configuration Script, and Remote Diagnostics menu items.

Send Command String

Allows single line commands to be sent to the tracker. This tool is provided to allow control over the tracker parameters not supported in the ISDEMO menus. For instance, this function can be used for test and debug purposes. Type in the command and press Enter or Return. The <CR LF> pair is automatically added to the end of the line before it is written to the serial port. See Appendix E—Interface Communications Protocol for a complete list of all available commands.

Configuration Script Tool

This utility provides complete control over the tracker parameters, including support for multiple configurations. Contents of the display area of the window can be edited directly, like in any text editor.
File

Load from File  Crtl+O
Opens a file selection dialog box. Configuration file must be a plain text file.

Save to File  Crtl+S
Used to save contents of the window to a text file.

Exit  Crtl+Q

Tracker

Retrieve from Tracker  F5
Queries the tracker for all possible configuration parameters, converts them to commands and displays the results in the window. This can then be saved to a file.

Send to Tracker
Sends all interface commands in the display area to the tracker. CR LF pair is automatically added to each line.

Remote Diagnostics
This feature of ISDEMO is designed to improve technical support by allowing an InterSense engineer to diagnose a tracker remotely, eliminating the need for the customer to spend a significant amount of time on the phone.

To use this feature the tracker has to be connected to a PC with a working connection to the Internet. Firewall introduces some difficulty, but it should still work. An InterSense technical support engineer will walk you through the required procedure.
When connected, ISDEMO becomes a relay, passing serial port data to a remote host. Commands sent from the remote host are also relayed to the tracker. InterSense engineers at the remote computer can run diagnostics software as if the tracker was connected to that computer directly.

There are two ways of connecting to the remote host. ISDEMO can listen to the connection requests on the specified port, or it can try to connect itself. The first method is preferred as it makes it easier for the InterSense engineer to reconnect if connection is lost for any reason. For this to work the PC can’t be behind a firewall (proxy) and InterSense engineer must know its IP address. To diagnose the tracker with this method do the following:

1. Make sure that ISDEMO can communicate with the tracker.
2. Open the Remote Diagnostics tool.
3. Write down the IP address displayed in Local Info line.
4. Make sure protocol selection is set to TCP, port to 5001. If this is not possible, notify InterSense.
5. Click on Listen button and confirm by reading the message.
6. Call InterSense or send email containing the IP address and port number.

If your PC is behind a firewall, ISDEMO will need to connect via the second method. To connect in this way, follow these steps:

1. Make sure that ISDEMO can communicate with the tracker.
2. Open the Remote Diagnostics tool.
3. Call or email InterSense to obtain the Server IP Address.
4. Make sure that protocol selection is set to TCP and port to 5001. If this port is not available, other numbers can be used, provided that InterSense engineer is notified.
5. Enter IP Address and click on Connect button.
6. Watch the message area of the window for status information.
7. If connection is lost prematurely, try to reconnect.

For unattended operation or if link is intermittent, please make sure that Reconnect Automatically option is selected.

It is desirable to have the InterSense technician on the phone during the diagnostics session, as he or she might have questions about the physical configuration and position of the tracker. If this is not convenient, a simple chat client is build into the program. It allows one-line messages to be sent to and from the remote host. Messages are displayed in the text window. To send a message, open Send Message control in the Commands menu.

4.8 Compass Calibration Tool

Use the compass calibration procedure to compensate for the effects of static magnetic field distortions caused by objects that the InertiaCube is mounted on (i.e. HMDs, cameras, hand-held computers, etc.). Please keep in mind that calibration can't compensate for dynamically changing magnetic fields, so the InertiaCube must be kept away from CRT monitors, electric motors, and anything that has a moderate to strong electric current flowing through it.

Note: Compass calibration is not available when the InertiaCube3 is connected to the IC3 Processor. The InertiaCube3 must be connected directly to the Windows PC running ISDEMO (or by the wireless link with the Wireless InertiaCube3).

During calibration, you will be asked to rotate the sensor covering as much range as possible. Rotation must be done at moderate speed. The sphere surrounding the InertiaCube represents all possible orientations. The objective during calibration is to get each of the 3 axes to intersect as many of the triangles that form that sphere as possible. When a surface triangle in this sphere is
intersected, it acquires the color component of the intersecting axis, providing a visual cue to help with the process. Once all 3 axes have intersected a particular surface triangle, it becomes white. It is not necessary to cover the entire surface of the sphere with white during calibration, but at least 70% is recommended to guarantee accurate calibration, and 50% minimum is required.

Compass correction is turned off while this utility is active and will be turned on when it is closed.

To begin the compass calibration, pick up the sensor and press 'Start' button. When the calibration is complete, the ‘Start’ button becomes an ‘Apply’ button. The new computed calibrated values are displayed in the window and are applied to the Flash RAM when the ‘Apply’ button is pressed. Press the ‘Cancel’ button to abort the calibration procedure without saving any new values to the Flash RAM in the InertiaCube3. Once the values are applied, the ‘Apply’ button is replaced with the ‘Start’ button the ‘Cancel’ button is replaced with the ‘Close’ button. ‘Close’ closes the calibration window.
Compass Calibration ➔ Commands

The Commands ➔ Restore to Factory Calibration menu provides a way to restore the original factory calibration to the InertiaCube3. The factory calibrated biases and scalar data, which is stored in Flash RAM, is displayed for each axis in the Compass Calibration window.

Compass Calibration ➔ Options ➔ Calibration Duration

The default calibration process duration is 1 minute, but a longer (2 minutes) or shorter (30 seconds) can be selected.
Compass Calibration ➔ Options ➔ Calibration Axis

By default, a full 3-axis magnetometer calibration is performed when selecting the ‘Start’ button. For special cases where the mounted InertiaCube3 will only rotate about the z-axis (i.e. on a vehicle) a 2-axis magnetic calibration can be selected.

Compass Calibration ➔ Options ➔ Display Options

The Rotate Scene display option is selected by default. It keeps the sphere in the window moving with a slight oscillation to provide a visual reference to the progress of calibration process.
4.9 Magnetic Environment Calibration Tool

4.9.1 Theory of Operation

The InterSense InertiaCube sensors measure the Earth’s magnetic field along three perpendicular axes to calculate the direction of magnetic north. This data is used as reference for yaw (heading), and prevents any drift accumulation in the inertial system. As with any compass, local disturbances of the Earth’s magnetic field can corrupt data and cause errors in the sensor output. By characterizing and storing normal magnetic field values it is possible to detect such disturbances and prevent them from negatively affecting tracking performance. The Magnetic Environment Calibration Tool was developed to measure the normal magnetic inclination and field strength for a particular environment, store it in permanent sensor memory, and tune how it affects integration of compass data in tracking algorithms.
The Earth's field is closely approximated by the field of a dipole magnet positioned at the centre of the Earth. Magnetic inclination (dip angle) is the angle that the geomagnetic field is tilted with respect to the surface of the earth. Magnetic inclination varies from 90° at the magnetic poles (perpendicular to the surface) to 0° at the magnetic equator (parallel to the surface). The strength of the field at the Earth's surface ranges from less than 0.3 gauss to over 0.6 gauss, depending on the location. Both dip angle and field strength can also be affected by building materials and other sources, therefore calibration will only be valid at the specific location where it was performed.

4.9.2 Algorithm

The InterSense 3-DOF tracking algorithm uses Kalman filters to estimate and correct drift and errors based on data from the reference sensors, in this case the magnetometer. The Kalman filters assign “noise” values to the inputs based on the known sensor characteristics and other parameters; discounting the affect of the compass on the output. When nominal values for magnetic field inclination and strength are known it will use them to calculate “quality” of the magnetometer data. This calculation uses tuning parameters and is based on how much the compass data deviates from the calibrated values. When the input falls outside of the range allowed by the tuning parameters no compass data is used. The system can continue to accurately track orientation using only gyro data until magnetic interference is removed and the compass data can be used again.

4.9.3 Starting Calibration Procedure

The Calibration Tool is located in the Tools menu of the main ISDemo window. The type of calibration can be selected in from the Options Menu.
4.9.4 Calibration Procedure

During the calibration procedure, the system collects magnetic field data and displays it in the form of histograms for inclination (dip angle) and field strength (magnitude). A third 3-dimensional histogram is a combination of both data sets, and provides additional visual feedback. The Dip Angle data is displayed in green throughout the interface; Magnitude data is in blue. Tuning parameters and graphs are in yellow.
You can select calibration duration from the Options menu, default is 1 minute. During calibration, the sensor should be moved and rotated at a moderate speed, covering as much of the tracked volume as possible. It should be kept away from any potential sources of magnetic interference, such as metal furniture, electronics, etc. Histograms should have pronounced peaks.

### 4.9.5 Calibration Results

After the end of the calibration period a new Dip Angle and Magnitude are calculated and can be store in the sensor’s EEPROM by pressing the Apply button. The interface is updated and the tuning parameters are displayed in the form of a yellow line, covering what is now considered usable compass data. To adjust the tuning parameters, use the Magnetic Field Compensation slider control at the bottom of the screen.

### 4.9.6 Testing and Tuning

After calibration data is stored in the sensor’s EEPROM, the system will be able to start calculating compass data quality and display it on the screen. It also displays 2 different Yaw values, first is the normal output of the sensor, second is the pure compass yaw as reported by the sensor. By comparing the values when magnetic interference is introduced you can determine the effectiveness of the calibration and select the appropriate Magnetic Field Compensation factor. In a very clean magnetic environment a higher level of compensation may be appropriate. This will guarantee that compass data is heavily discounted whenever data diverges from the stored nominal values. If you expect a lot of interference, a lower value of compensation may be appropriate, allowing for more compass data to be used. The system can track well without the use of compass for some time before any significant drift accumulation. However, it is important to allow the Kalman filter algorithm to use enough compass data to maintain stability and accuracy. The default value is Medium and it works well under most conditions.
InertiaCube3 Manual
Doc. No. 072-00094-0D05 Rev.2.1
5 Developer’s Instructions

For InterSense SDK Version 4.0 or higher.

Please refer to the document ‘dll_api.pdf’ located in the SDK folder for further details, functions, and sample code. This document describes the interface to be used by the application software to initialize and retrieve data from the InterSense devices using the ISENSE.DLL. This dynamic link library is provided to simplify communications with all models of InterSense tracking devices. It can detect, configure, and get data from up to 32 trackers. The DLL maintains compatibility with existing devices, and also makes the applications forward compatible with all future InterSense products (new DLLs may be required, but the application will not need to be recompiled).

5.1 Sample Program

The DLL is distributed with sample programs written in C and C# (for Windows) to demonstrate usage. It includes a header file with data structure definitions and function prototypes. Most of the API description below can also be obtained from the header file.

main.c       Main loop of the program. All API calls are made from here.

isense.c     DLL import procedures. This file is included instead of an import library to provide compatibility with all compilers.

isense.h     Header file containing function prototypes and definitions. This file should not be modified.

types.h      Header file containing data type definitions.
6 Appendix A – Frequently Asked Questions

Q1. What is the maximum length of the cable between the InertiaCube3 and the computer?

The cable between the InertiaCube and the computer has been tested to a length of 100 feet. InterSense can provide longer cables. Please contact your sales representative for information.

Q2. Does the InertiaCube have batteries? How often do they have to be changed?

The InertiaCubes do not contain batteries. When remotely powered with 4 AA alkaline batteries (6 VDC) or a single 9 VDC alkaline battery, the batteries should be changed after 8 hours of continuous use.

Q3. Are all the interconnection cables shielded?

Yes.

Q4. What is the MTBF of each component separately?

Based on supplier data, the MTBF for the InertiaCube3 is estimated at 5 years.

Q5. What type of shock can the InertiaCube3 sustain?

These InertiaCube is designed to withstand a maximum acceleration of 500 g. This means that a direct impact on the devices are not recommended. The InertiaCubes can withstand a higher level of shock if installed on the inside of an object, or mounted on rubber.

Q6. What are the PIN assignments on the DB9 on the InertiaCube3?

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DCD</td>
</tr>
<tr>
<td>2</td>
<td>RX</td>
</tr>
<tr>
<td>3</td>
<td>TX</td>
</tr>
<tr>
<td>4</td>
<td>DTR</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
</tr>
<tr>
<td>6</td>
<td>DSR</td>
</tr>
<tr>
<td>7</td>
<td>RTS</td>
</tr>
<tr>
<td>8</td>
<td>CTS</td>
</tr>
<tr>
<td>9</td>
<td>RI</td>
</tr>
</tbody>
</table>

Currently, the InertiaCube3 uses four wires; RX, TX RTS, and GND.

Q7. Do you have any advice about working with software packages?

Consult with the software vendor or contact InterSense techsupport@intersense.com.

Q8. How do I know whether I have the latest release of ISDEMO?

Check our web site, the URL is http://www.intersense.com/support.html. Click on the ISDEMO.ZIP hypertext link. We always post the latest release for you to download.
7 Appendix B – USB Driver Installation

7.1 InterSense USB Adapter Installation on Windows 2000 and XP

InterSense USB Adapter utilizes FTDI USB UART device. This document details installation of the FTDI Win2k Drivers and was prepared using FTDI documentation. FTDI is the registered trademark of the Future Technology Devices International Ltd.

Future Technology Devices International Ltd.  
St. George's Studios,  
93 - 97 St George's Road,  
Glasgow G3 6JA  
Scotland U.K.

Web Site URL - http://www.ftdichip.com

7.1.1 Install InterSense Support Software

Install InterSense support software from the included CD. This step must be completed before attempting to install the drivers. FTDI Drivers are installed onto your hard drive under InterSense\Drivers\USB (FTDI).

7.1.2 Installing USB Driver

1. Plug in InterSense USB Adapter into available USB port. Windows will start the “Found New Hardware Wizard”. Click “Next” to start driver installation.
2. Select “Search for a suitable driver” and click “Next”.

3. Select “Specify a location”, click “Next”.
4. The default InterSense installation folder is C:\InterSense, if during installation you selected a different location your path will be different.

![Found New Hardware Wizard]

Inset the manufacturer's installation disk into the drive selected, and then click OK.

Copy manufacturer's files from:

C:\InterSense\Drivers\USB (FTDI)
5. Click “Next” to install the driver.

[Image of the Found New Hardware Wizard]

[Found New Hardware Wizard]

Driver Files Search Results
The wizard has finished searching for driver files for your hardware device.

The wizard found a driver for the following device:
- USB to Serial adapter

Windows found a driver for this device. To install the driver Windows found, click Next.

- \Intersense\drivers\usb\Vhid\Vhidbus.inf

[Found New Hardware Wizard]

Completing the Found New Hardware Wizard
- USB High Speed Serial Converter

Windows has finished installing the software for this device.

To close this wizard, click Finish.

[Image of the Found New Hardware Wizard]
6. Next Windows will automatically start installation of the USB Serial Port

7. Select “Search for a suitable driver”, click “Next”.

![Image of Found New Hardware Wizard]

To continue, click Next.

![Image of Install Hardware Device Drivors]

This wizard will complete the installation for the device:

USB Serial Port

A device driver is a software program that enables a hardware device to work with an operating system.

What do you want the wizard to do?

- [ ] Search for a suitable driver for my device (recommended)
- [ ] Display a list of the known drivers for this device so that I can choose a specific driver

Next > Cancel
8. Select “Specify a location”, click “Next”.

9. The default InterSense installation folder is C:\InterSense, if during installation you selected a different location your path will be different.
10. Click “Next” to install the driver.
7.1.3 Changing COM Port Number

1. InterSense software supports COM Port numbers 1 through 10, so it may be necessary to change the default port number assigned to the USB Adapter. From Control Panel select “System”, go to the Hardware tab and open Device Manager. Open the “Ports” section. Double-click on “USB Serial Port” to open Properties window.

2. In the Com Port Properties window select “Port Settings”, click “Advanced”. Choose the Com Port number and click “OK”.
7.2 InterSense USB Adapter Installation on Windows 98/ME

InterSense USB Adapter utilizes FTDI USB UART device. This document details installation of the FTDI Win98 Drivers and was prepared using FTDI documentation. FTDI is the registered trademark of the Future Technology Devices International Ltd.

Future Technology Devices International Ltd.
St. George's Studios,
93 - 97 St George's Road,
Glasgow G3 6JA
Scotland U.K.

Web Site URL - http://www.ftdichip.com

7.2.1 Install InterSense Support Software

Install InterSense support software from the included CD. This step must be completed before attempting to install the drivers. FTDI Drivers are installed onto your hard drive under InterSense\Drivers\USB (FTDI).

7.2.2 Installing USB Driver

1. Plug in InterSense USB Adapter into available USB port. Windows will start the New Hardware Wizard. Click “Next” to start driver installation.
2. Select “Search for best driver” and click “Next”.

3. Select “Specify a location”, then click “Browse”. The default InterSense installation folder is C:\InterSense, if during installation you selected a different location your path will be different.
4. Click “Next” to install the drivers.

Add New Hardware Wizard

Windows driver file search for the device:

USB High Speed Serial Converter

Windows is now ready to install the best driver for this device. Click Back to select a different driver, or click Next to continue.

Location of driver:

C:\INTERS~1\DRIVERS\USB\FT~1\FTDIBL

Finish

Add New Hardware Wizard

USB High Speed Serial Converter

Windows has finished installing the software that your new hardware device requires.

Finish
7.2.3 Changing COM Port Number

1. InterSense software supports COM Port numbers 1 through 10, so it may be necessary to change the default port number assigned to the USB Adapter. From Control Panel select “System”, then go to the Device Manager tab. Select “View by type”, then open the “Ports” section. Select “USB Serial Port” and click “Properties”.

2. In the Com Port Properties window select “Port Settings”, then click “Advanced”. Choose the Com Port number and click “OK”.

![System Properties](image)
## 8 Appendix C – Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Reason/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISDEMO doesn’t work when using either the USB or RS-232 Serial InertiaCube3</td>
<td>1) The “DLL Compatible” option in the startup window of ISDEMO was not selected.</td>
</tr>
<tr>
<td>ISDEMO doesn’t work when using the RS-232 interface of the IC3 Processor</td>
<td>Most common reasons (not in any order):</td>
</tr>
<tr>
<td></td>
<td>1) Connected to wrong COM port plug on the back of the computer.</td>
</tr>
<tr>
<td></td>
<td>2) The selected serial port is captured by another program and can’t be opened by ISDEMO.</td>
</tr>
<tr>
<td></td>
<td>3) Serial port not capable of running at 115,200 baud rate. This is usually due to older computers that cannot run at 115,200 baud. The problem is a lack of a proper UART such as the 16550.</td>
</tr>
<tr>
<td></td>
<td>4) Incorrect port settings - use autodetect for Com parameters.</td>
</tr>
<tr>
<td></td>
<td>5) Not using Start Displaying Data. It may be necessary to select Stop Displaying Data first.</td>
</tr>
<tr>
<td></td>
<td>6) Make sure Station 2 is selected from the Display ➔ Current Station menu item in ISDEMO.</td>
</tr>
<tr>
<td>ISDEMO is running, but system does not track</td>
<td>Check for the following:</td>
</tr>
<tr>
<td></td>
<td>1) The InertiaCube3 is not plugged in.</td>
</tr>
<tr>
<td></td>
<td>2) The InertiaCube3 was plugged in after power up and a detect command has not been issued</td>
</tr>
<tr>
<td>InertiaCube3 interference or lack of accuracy</td>
<td>Check for the following:</td>
</tr>
<tr>
<td></td>
<td>1) Placement directly on top of metal. You should place the InertiaCube3 an inch or two away. If the InertiaCube3 must be mounted in a metallic environment, follow the steps in Section 4.7 to perform a magnetic calibration using the “Compass Calibration Tool”.</td>
</tr>
<tr>
<td>Orientation is drifting uncontrollably</td>
<td>1) Make sure that InertiaCube3 is properly plugged in.</td>
</tr>
<tr>
<td></td>
<td>2) Keep InertiaCube3 still for 10 seconds after connecting with ISDEMO or DLL.</td>
</tr>
<tr>
<td></td>
<td>3) Compass is turned off in ISDEMO.</td>
</tr>
</tbody>
</table>
9 Appendix D – Health and Safety warnings and guidelines

Important: Most of the side effects described in this section usually only occur when a tracking device, like an InertiaCube3, is used with personal displays or 3D glasses. The symptoms listed below are usually referred to as “Simulator Sickness”.

Read and follow the user instructions.

Before using InertiaCube3, read and follow the user instructions. In exceptional circumstances, failure to read and follow the user instructions could result in possible side effects that may lead to accidental injury during or after use.

Recommended use:

- For use only by persons 15 years of age or older.

This system should not be used by:

- Persons under the influence of drugs and alcohol.
- Pregnant women.
- Persons suffering from a heart condition
- Persons with a history of epilepsy.

Take frequent breaks.

It is recommended that InertiaCube3 should be used for no more than one hour at a time. After that you should take a 15-minute rest break before re-use regardless of how you feel. If you feel uncomfortable at any time, stop using immediately.

Rest after using.

Rest for at least 15 minutes after using InertiaCube3 even if you feel fine and have experienced none of the symptoms described below. If you have experienced any undesirable effects or symptoms, rest until they are completely gone. Do not walk, drive, ride a bike or operate equipment until you have rested, otherwise you risk injury to yourself and others.

Epilepsy and seizures.

A very small part of the population has a condition that may result in epileptic seizures or loss of consciousness. If you or anyone in your family has epilepsy or has experienced seizures or loss of consciousness, do not use InertiaCube3 without first consulting your physician. Persons who have not experienced seizures or loss of consciousness may still have an epileptic condition. We recommend that a non-user is always present when InertiaCube3 is being used.
Additional possible risks of harm.

While tracking technology has been used for many years, the range of sensors that are used to calculate positional and angular data continues to develop. Over the last twenty years as considerable amount of research has been conducted into possible side effects induced in users of real time computing systems that include various types of tracking sensors. This research has reported the symptoms described below from some users of these systems.

InertiaCube3 has been designed using the latest sensor technologies and we believe that the possibility of such symptoms occurring has been minimized. However, it is not possible to design for the individual characteristics of each user and it is possible that users will experience one or more of the side effects described below. Historic research shows that the effects or symptoms ordinarily occur during and immediately after use and should diminish quickly once the user stops using the system.

We want you to make an informed and responsible choice about using the InertiaCube3. Accordingly, we warn you that even if you read and follow the User Instructions, you may experience one or more of the following effects or symptoms if you use InertiaCube3 with a personal display—eye strain, altered vision, eye or muscle twitching, headaches, neck and shoulder strain, nausea and vomiting, disorientation, dizziness, impaired balance and stability, drowsiness, fainting, fatigue, sweating, extreme paleness, impaired hand-eye or other co-ordination.

Each effect or symptom, if it occurs, should be temporary and may last from a few minutes to 30 minutes.
10 Appendix E – Interface Communication Protocol

For firmware version 4.22 or higher

10.1 Commands Sent from the Host to the Tracker

<> Carriage return line feed pair- not needed for single character commands.


{} List of parameters required for command.
[] List of optional parameters for command. Omitting them results in a query.

The IC3 Processor emulates most (but not all) of the commands in the Polhemus Fastrak™ protocol, thus it is possible to use the IC3 Processor with most applications without writing new driver code.

Note:
Firmware version 3.xx extended Fastrak™ protocol to support up to 32 stations (actual number allowed is determined by your hardware configuration). StationNum in commands, status and data records is now encoded in an extended hexadecimal notation. Numbers 1 to F conform to standard hexadecimal notation, with numbers greater that F represented by additional upper case letters of the alphabet. For example, number 16 is displayed as G.

10.2 Standard Fastrak™ Interface Commands

Data Record Request

P Request a data record from all active stations. Only used in polled mode.

Output mode

C Put in continuous output mode.
c Put in polled output mode.

Default Polled mode

Alignment Reference Frame

A{stationNum},[Ox,Oy,Oz,Xx,Xy,Xz,Yx,Yy,Yz]<> Sets the coordinate frame with respect to which outputs for that station will be reported. The coordinate frame is defined by a set of three points. Ox,Oy,Oz defines the origin of the new coordinate system. Xx,Xy,Xz defines a point on the positive x-axis and Yx,Yy,Yz defines a point on the positive y-axis. The effect of this command is incremental, or relative to any current alignment reference frame already in place. If optional parameters are omitted, current values are returned.

Reset Alignment Reference Frame
**Boresight Reference Angles**

\[ G\{stationNum\}, [yawref, pitchref, rollref] \]

Sets the boresight reference angles for the specified station. If set, these values are then used by the next Boresight command instead of current orientation. If optional parameters are omitted, current reference angles are returned.

**Default** 0,0,0

**Boresight Compatibility Mode**

\[ MBF<> \] Switch system to Fastrak™ Compatible mode.

\[ MBI<> \] Switch system to Firmware Version 2.x Compatible mode.

In firmware versions prior to 3.00 the \[ B\{stationNum\} <> \] command was implemented as the Heading Boresight (see below) and full boresight was not available. To maintain compatibility with the user software written at that time, two Boresight Compatibility modes are available. In Fastrak™ Compatible mode \[ B\{stationNum\} <> \] command executes full 3-DOF boresight and \[ MB\{stationNum\} <> \] effects heading only. In the Firmware Version 2.x Compatible mode the meanings of these commands are reversed.

**Default** Firmware Version 2.x Compatible, \[ MBI<> \]

**Boresight**

\[ B\{stationNum\} <> \] (Fastrak™ compatibility mode)

\[ MB\{stationNum\} <> \] (Firmware Version 2.x compatibility mode)

Boresight a station. If boresight reference angles have been specified by the \[ G\{stationNum\}, [yawref, pitchref, rollref] \] command prior to issuing of Boresight command then that orientation becomes the new reference point. The angles output by the tracker at that orientation become zero. Otherwise, system uses current station orientation and that becomes the new reference line of sight. Please make sure that the object being tracked (like an HMD) is leveled and is pointing down the x-axis when boresighting a station.

**Unboresight**

\[ b\{stationNum\} <> \] (Fastrak™ compatibility mode)

\[ Mb\{stationNum\} <> \] (Firmware Version 2.x compatibility mode)
Unboresight a station. Reference angles are cleared for the specified station.

**Heading Boresight**

- $B\{\text{stationNum}\}<>$ (Firmware Version 2.x compatibility mode)
- $MB\{\text{stationNum}\}<>$ (Fastrak™ compatibility mode)

**Heading Unboresight**

- $b\{\text{stationNum}\}<>$ (Firmware Version 2.x compatibility mode)
- $Mb\{\text{stationNum}\}<>$ (Fastrak™ compatibility mode)

**Set Serial Communication Parameters**

- $o\{\text{rate, parity, bits, HHS}\}<>$ Change the serial communication parameters

  - **rate** is one of $3, 12, 24, 48, 96, 192, 384, 576, 1152$ (rate is multiplied by 100)
  - **parity**
    - N = none
    - O = odd
    - E = even
  - **bits** 7 or 8
  - **HHS** (Hardware handshake)
    - 0 = OFF
    - 1 = ON

**Default serial communications settings:**

- **Baud** 1152
- **Parity** N
- **bits** 8
- **HHS** OFF

**System Record Request**

- $S$ Request a system status record to be sent.

**Station Status**

- $l\{\text{stationNum}\},[\text{state}]<>$ Set the stationNum on or off.

  - **state** 0 = OFF, 1 = ON

**Default** All connected stations are on

**Output Units Control**

- $U$ Sets output data record position units to inches.
- $u$ Sets the position units to centimeters. These only matter in 6-DOF mode.

**Default** U

**System control**

- $^K$ Save the current settings to nonvolatile memory.
- $W$ Restore the system settings to the factory defaults.
- $^Y$ Restart the firmware to the power up condition.
\textasciitilde S \quad \text{Suspend data transmission.}
\textasciitilde Q \quad \text{Resume data transmission.}

\textbf{Caution:} Sending \textit{W} command will cause all the user configuration information to be lost.

\textbf{Output record mode}

- \textit{F} \quad \text{Put in ASCII output mode}
- \textit{f} \quad \text{Put in Binary output mode.}

\textbf{Default \quad F}

\textbf{Output record list settings} \quad O\{stationNum\},[p1],[p2],[p3],…..,[pn]<>

Sets the output data list for \textit{stationNum}. If optional parameters are omitted, a data record containing current output list settings for the station is returned.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Output Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>ASCII space character</td>
<td>1 ASCII byte</td>
</tr>
<tr>
<td>1</td>
<td>ASCII CR, LF pair</td>
<td>2 ASCII bytes</td>
</tr>
<tr>
<td>2</td>
<td>x, y, z position coordinates</td>
<td>3 floats</td>
</tr>
<tr>
<td>4</td>
<td>yaw, pitch and roll Euler angles</td>
<td>3 floats</td>
</tr>
<tr>
<td>5</td>
<td>X-axis direction cosines</td>
<td>3 floats</td>
</tr>
<tr>
<td>6</td>
<td>Y-axis direction cosines</td>
<td>3 floats</td>
</tr>
<tr>
<td>7</td>
<td>Z-axis direction cosines</td>
<td>3 floats</td>
</tr>
<tr>
<td>11</td>
<td>orientation quaternion</td>
<td>4 floats</td>
</tr>
<tr>
<td>16</td>
<td>stylus switch status (always 0)</td>
<td>1 byte (ASCII or binary,</td>
</tr>
<tr>
<td>18</td>
<td>x, y, z in 16 bit binary format</td>
<td>see below</td>
</tr>
<tr>
<td>19</td>
<td>yaw, pitch and roll in 16 bit binary format</td>
<td>see below</td>
</tr>
<tr>
<td>20</td>
<td>quaternion in 16 bit binary format</td>
<td>see below</td>
</tr>
<tr>
<td>21</td>
<td>time stamp, in selected time units</td>
<td>see section 5.3.1</td>
</tr>
<tr>
<td>22</td>
<td>buttons</td>
<td>see below</td>
</tr>
<tr>
<td>23</td>
<td>joystick</td>
<td>see below</td>
</tr>
<tr>
<td>40</td>
<td>tracking status</td>
<td></td>
</tr>
<tr>
<td>68 – 71</td>
<td>auxiliary inputs</td>
<td></td>
</tr>
</tbody>
</table>

\textbf{Default \quad 2,4,1}
Data Item 4 – Euler Angles.

The Euler angles are defined as rotations about Z, then Y, then X in body frame. Angles are returned in degrees.

Data Items 5, 6, 7 – Direction Cosines.

X-axis, Y-axis and Z-axis direction cosines can be used to construct a 3x3 rotation matrix.

\[
\begin{bmatrix}
x_1 & x_2 & x_3 \\
y_1 & y_2 & y_3 \\
z_1 & z_2 & z_3
\end{bmatrix}
\]

X direction cosines.

Y direction cosines.

Z direction cosines.

This matrix can also be constructed from Euler angles:

\[
\begin{bmatrix}
\cos(P)\cos(Y) & \sin(R)\sin(P)\cos(Y) - \cos(R)\sin(Y) & \cos(R)\sin(P)\cos(Y) + \sin(R)\sin(Y) \\
\cos(P)\sin(Y) & \sin(R)\sin(P)\sin(Y) + \cos(R)\cos(Y) & \cos(R)\sin(P)\sin(Y) - \sin(R)\cos(Y) \\
-sin(P) & \cos(P)\cos(R) & \cos(P)\sin(R)
\end{bmatrix}
\]

Data Item 11 – Orientation Quaternion.

Quaternion is returned as \(q = [w, x, y, z]\). Quaternion to rotation matrix conversion can be accomplished using the following formula:

\[
\begin{bmatrix}
1-2y^2 - 2z^2 & 2xy - 2wz & 2xz + 2wy \\
2xy + 2wz & 1 - 2x^2 - 2z^2 & 2yz - 2wx \\
2xz - 2wy & 2yz + 2wx & 1 - 2x^2 - 2y^2
\end{bmatrix}
\]
Data Items 18, 19, 20 – 16 bit binary format.

16 bit binary format can be used in applications requiring fastest possible serial I/O. Each floating point number is stored in 2 bytes with only 14 bits containing actual data. This results in lower accuracy than the standard IEEE floating point format.

Data is 2’s-complement. The first byte of the data set has its high-order bit set to 1, all others have them set to zero. This can be used for data synchronization. Data is returned low-order byte, then high-order byte. Use following code sample as an example on how to decode this format:
To decode position:

\[
\text{lo} = (\text{dataRecord}[3] \& 0x007F); \\
\text{hi} = (\text{dataRecord}[4] \& 0x007F); \\
\text{int14bit} = (\text{lo} \ll 2) \mid (\text{hi} \ll 9); \\
\text{result} = (\text{float}) \text{int14bit} * 3.0 / 32768.0;
\]

Result is a number representing position (in meters) and has a full range of ± 3.0 meters (−300.0 to +299.963 centimeters or −118.110 to 118.096 inches).

To decode Euler angles:

\[
\text{lo} = (\text{dataRecord}[3] \& 0x007F); \\
\text{hi} = (\text{dataRecord}[4] \& 0x007F); \\
\text{int14bit} = (\text{lo} \ll 2) \mid (\text{hi} \ll 9); \\
\text{result} = (\text{float}) \text{int14bit} * 180.0 / 32768.0;
\]

Resulting number represents orientation and has a full range of ± 180.0 (−180.0 to +179.978) degrees.

To decode Orientation Quaternion:

\[
\text{lo} = (\text{dataRecord}[3] \& 0x007F); \\
\text{hi} = (\text{dataRecord}[4] \& 0x007F); \\
\text{int14bit} = (\text{lo} \ll 2) \mid (\text{hi} \ll 9); \\
\text{result} = (\text{float}) \text{int14bit} * 1.0 / 32768.0;
\]

Resulting quaternion value has range of ± 1.0.

Data Item 22 – Buttons.

One 3-digit integer in ASCII format or one byte in binary format.

Bits represent the button states of a station’s buttons. If a button is pressed, the corresponding bit is 1 otherwise it is 0. The bit assignments for the wand are (where bit 0 is the least significant bit):

<table>
<thead>
<tr>
<th>Bit</th>
<th>Button</th>
<th>Minitrax Wand button color</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>yellow</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>red</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>green</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>blue</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>center (press joystick)</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>black</td>
</tr>
</tbody>
</table>
Data Item 23 - Joystick.

Two integers, one for each axis, values ranging from 0 to 255. Two 3-digit integers in ASCII format or two 1-byte unsigned values in binary format. Values at limits and at center are:

<table>
<thead>
<tr>
<th>Axis</th>
<th>Position</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>left/right (1st integer)</td>
<td>left</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>center</td>
<td>127</td>
</tr>
<tr>
<td></td>
<td>right</td>
<td>255</td>
</tr>
<tr>
<td>front/rear (2nd integer)</td>
<td>rear</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>center</td>
<td>127</td>
</tr>
<tr>
<td></td>
<td>front</td>
<td>255</td>
</tr>
</tbody>
</table>

Define Tip Offsets

\[ N\{stationNum\},[Ox, Oy, Oz]\] \(<>\)

By default, the point being tracked is for each InertiaCube3 is at the center of the bottom plate of the enclosure.

This command allows the user to define a set of position offsets, so a different point can be tracked. Offsets are measured in the body coordinate frame of the MiniTrax station and are entered in centimeters. If optional parameters are omitted, current settings are returned.

Default 0,0,0

Position Operational Envelope

\[ V\{stationNum\},[Xmax, Ymax, Zmax, Xmin, Ymin, Zmin]\] \(<>\)

This command sets the boundaries of the area where position is to be tracked. Whenever a station leaves the defined range, position tracking is stopped and only resumed once it is back within the defined boundaries. Parameters are entered in meters. If optional parameters are omitted, current settings are returned.

Default 200,200,200,-200,-200,-200
10.3 Fastrak™ commands implemented for compatibility only

Hemisphere \[H\{stationNum\},[p1,p2,p3]\langle\]

Sets the tracking hemisphere for a magnetic tracking system. Because InterSense trackers are not magnetic the parameters are ignored. However, they can be set and then queried for compatibility with software such as MultiGen SmartScene or Immersion Corporation haptic Software. If optional parameters are omitted, a data record containing current Hemisphere settings for the station is returned.

Default 1,0,0

10.4 InterSense Specific Commands

All InterSense specific commands start with the letter M (for “Manufacturer-specific”) and must be completed by a CR,LF pair.

10.4.1 System Configuration Commands

Time Units

The time stamp recorded is the time when the tracker data was collected from the hardware. The time index is set to zero when tracker is first turned on.

\[MT\langle\]

Sets the units for the data record time stamp to milliseconds.

\[Mt\langle\]

Sets the units for the data record time stamp to microseconds.

Default T

Set Current Time to Zero

\[MZ\langle\]

This command sets current time index of the tracker to zero.
Set Ethernet Communication Parameters

\textit{MEthIp[address]}<> Sets System IP address.

Use dotted format like 192.168.1.1. If address is omitted, the current address is returned, \textit{31EI[address]}<>. The IP address takes effect immediately unless an address was already set, in which case system settings must be saved and the system must be restarted.

\textit{MEthUdp[state]}<> Sets state of UDP broadcast.

\text{\textit{state}=1} to enable, \textit{state}=2 to disable (default).

\textit{MEthUdpPort[port]}<> Sets UDP broadcast port.

**Default Ethernet communications settings:**

\begin{itemize}
  \item \textbf{UDP state} \hspace{1cm} \textit{OFF}
  \item \textbf{UDP port} \hspace{1cm} 5001
  \item \textbf{IP address} \hspace{1cm} Empty
\end{itemize}

InterSense System Status Record Request

\textit{MS<>} Request the manufacturer-specific system status record. This is information about parameters which are specific to the InterSense product, additional to the standard system status information obtained using the \textit{S} command.

Tracking Status Record Request

\textit{MP<>} Requests tracking status information for all 12 stations. See Section 9.5.5 for the description.

Ultrasonic Timeout Interval

\textit{MU[interval]}<> This command has no effect with the IC3 Proc.

**Default** \hspace{1cm} set internally

Ultrasonic Receiver Sensitivity

\textit{Mg[Level]}<> This command has no effect with the IC3 Proc.

**Default** \hspace{1cm} set internally
**Genlock Synchronization**  
$MG[State, Rate]<>$

*State*  
- 0 – Genlock is off
- 1 – Reserved
- 2 – External sync, manual (supply strobe rate)
- 3 – Internal sync, supply output record rate

*Rate*  
Value in Hertz used with $State = 2$ and $3$

**Default**  
0

**Genlock Phase**  
$MGP[Param]<>$

*Param* can be the Phase (0 to 100%) or ‘+’ to increase to the next phase point, or ‘-’ to decrease to the next phase point. Please see Appendix F for complete details.

**Default**  
0

**Genlock Sync Source**  
$MGS[source]<>$

*source*  
- 1 – TTL
- 2 – NTSC

**Configuration Lock**  
Configuration lock commands are used to prevent unintentional changes to tracker configuration. Two Levels of protection are provided. The first prevents changes to saved settings. The second prevents changes to current unsaved (session) settings as well as saved settings.

$MConfigLockMode[mode]<>$

*mode*  
- 0 Lock off
- 1 Lock saved settings
- 2 Lock saved and session settings

**Default**  
0

In mode 1 (lock saved settings), the Fastrak commands to save current ($^K$) and restore factory ($W$) settings are disabled. In mode 2 (lock saved and session settings), the Fastrak command to restore saved settings ($^Y$) is disabled as well as $^K$ and $W$. In mode 0 (lock off), $^Y$, $^K$ and $W$ are all enabled. When mode is changed, it is saved to nonvolatile memory without affecting any other saved settings. If mode is omitted, the current setting is returned. The LCD menu options to save and restore settings are not affected by lock mode.
Error reporting

Hardware and configuration errors are stored internally and can be reported to the application. If the application is not setup to accept error messages, or if you are not sure, error reporting should be disabled. This setting is not saved with tracker configuration, so error reporting is off every time tracker is turned on.

- \textit{ME}<>: Returns all errors, one per error message.
- \textit{MEC}<>: Clear all errors from internal list.
- \textit{MEI}<>: Enable error reporting.
- \textit{ME0}<>: Disable error reporting.

\textbf{Default}  \hspace{1cm} \textbf{Error reporting is OFF}

Command logging

Command logging captures all host commands into a file for debugging purposes. The log file holds a maximum of 500 kB. When the max size is reached, the file is rewound and overwritten with new entries. Long series of P and MP commands are abbreviated to save space. It is accessed by the following command set.

- \textit{MLogOpen}<>: Enables logging. If settings are saved, logging will remain on through reset. An existing log file is always appended to.
- \textit{MLogClose}<>: Disables logging.
- \textit{MLogClear}<>: Disables logging and deletes log file. Use MLogOpen to resume logging.
- \textit{MLogState}<>: Returns logging state (0=off, 1=on), \texttt{31LS\{0,1\}<>}
- \textit{MLogSend}<>: Outputs log file to host one command per line. \texttt{31LF\{timestamp in ms\}::<command<>}

The timestamp is a decimal number and is not zero-padded.

\section*{10.4.2 InterSense-specific Station Parameters}

\textbf{InterSense Station Status Record Request}

\texttt{Ms\{stationNum\}<>}
Request an individual sensor status record for stationNum. This is information about parameters which are specific to the InterSense product.

**Prediction Interval**

\[ \text{Mp\{stationNum\},[Interval]}\]

Sets the time-interval of prediction for stationNum. Interval is an integer number of time in milliseconds. Suggested range is 0-50 ms. This parameter is used for both position and orientation prediction. If optional parameter is omitted, current prediction value is returned.

**Default** 0

**Perceptual Enhancement Level**

\[ \text{MF\{stationNum\},\{Mode}\}}\]

In order to provide the best performance for a large range of various applications, 3 levels of perceptual enhancement are available. None of the modes introduces any additional latency.

Mode 0 provides the best accuracy. The drift correction adjustments are made immediately; no jitter reduction algorithms are used. This results in somewhat jumpy output (not recommended for head-tracking) but with lower RMS error. Use this mode for accuracy testing or for any application that requires best accuracy.

Mode 1 provides accuracy similar to that of mode 0, with an addition of a jitter reduction algorithm. This algorithm reduces the accuracy by only a small amount and does not add any latency to the measurements.

Mode 2 is recommended for use with HMD or other immersive applications. The drift correction adjustments are made smoothly and only while the sensor is moving, so as to be transparent to the user.

**Default** 2

**Compass Heading Correction**

\[ \text{MH\{stationNum, mode\}}\]

Turns on the stationNum's compass heading correction. To operate effectively, the magnetic field in the environment need to be homogeneous. **Only valid when an InertiaCube is being used as a station** (i.e. not valid for MiniTrax devices).

For an InertiaCube, the modes are defined:
Mode 0 - Compass is OFF, no heading compensation is applied. Not recommended, Modes 1 or 2 are preferred.

Mode 1 - Partial compass mode. Magnetometer readings are used to reduce drift and maintain stability, but not as an absolute measurement system. In this mode, system is much less susceptible to magnetic interference, but heading drift will slowly accumulate. This mode is particularly useful when high rotational sensitivity settings are used.

Mode 2 - FULL compass mode. Readings produced by the magnetometers inside the InertiaCube are used as the absolute reference orientation for yaw.

Default 2

\text{Mh}\{\text{stationNum}\}

Turns off the \text{stationNum}’s compass heading correction. There can be slow drift in the yaw direction. \textbf{Only valid when an InertiaCube is being used as a station (i.e. not valid for MiniTrax devices).}

\textbf{Rotational Sensitivity Level}

\text{MQ}\{\text{stationNum}\},[\text{Sensitivity Level}]<>

Adjusts rotational sensitivity of a station. These settings are applicable when the Perceptual Enhancement Level is set to level 1 or 2. Sensitivity Level is an integer 1 to 4 where 1 is the lowest and 4 is the highest sensitivity. If optional parameter is omitted, current value is returned.

Default 3

\textbf{Accel Sensitivity}

\text{MA}\{\text{stationNum}\},[\text{Level}]<>

Accel sensitivity is an advanced tuning parameter used to control how fast tilt correction, using accelerometers, is applied. Valid values are 1 to 4, with 2 as default. Default is best for head tracking in static environment, with user seated. Level 1 reduces the amount of tilt correction during movement. While it will prevent any effect linear accelerations may have on pitch and roll, it will also reduce stability and dynamic accuracy. It should only be used in situations when sensor is not expected to experience a lot of movement. Level 3 allows for more aggressive tilt compensation, appropriate when sensor is moved a lot, for example, when user is walking for long durations of time. Level 4 allows for even greater tilt corrections. It will reduce orientation accuracy by allowing linear accelerations to
effect orientation, but increase stability. This level is appropriate for when user is running, or in other situations when sensor experiences a great deal of movement. If level is omitted, the current value is returned.

**Default**

2
10.5 Records Returned from the Tracker to the Host

10.5.1 Format Considerations

Record Headers

The first byte of each record is used to identify its type.

0 – Data record.
2 – Fastrak® status record.
3 – InterSense manufacturer-specific status record.

Floating Point Numbers.

Floating point numbers can be returned as IEEE 32 bit floats or as ASCII numbers in X.xf notation, where:

\[
\begin{align*}
X & \quad \text{is the total number of characters used to represent the float.} \\
x & \quad \text{is the number of digits after the floating point.} \\
f & \quad \text{is a symbol indicating that number is a float.}
\end{align*}
\]

For example, number -42.6 in 10.4f format would look as follows: “-42.6000”

10.5.2 Status Record Hexadecimal Character Decoding.

System Status, Manufacturer Status, and Manufacturer Station records use Hexadecimal Characters to encode status data. Each character can be 0 to F and can encode 4 bits. Logical AND operator can be used to test specific bits. Please see following code example:

```c
unsigned short byte1, byte2, byte3;
char hexChar[2];

hexChar[1] = 0x00;
hexChar[0] = statusRecordBuffer[3];
sscanf(hexChar, "%x", &byte1);
hexChar[0] = statusRecordBuffer[4];
sscanf(hexChar, "%x", &byte2);
hexChar[0] = statusRecordBuffer[5];
sscanf(hexChar, "%x", &byte3);
```
10.5.3 *Fastrak™ System and Data Records*

**Data Record**

This record is sent in response to the *P* command in polled mode or continuously in continuous mode. A separate data record is sent for each active station. The list of data items in each station record depends on how the list was set up with the *O* command. For most of the commonly used data list items, the format depends on commands *F*, *f*, *U*, *u*, *MT*, *Mt*.

\[0\{stationNum\}\{status\}\{dataItem1, dataItem2, \ldots\}\]

*stationNum*

A hexadecimal number up to C (decimal 12)

*status*

An ASCII space character. This status byte is currently unused.

*dataItemX*

**ASCII**

In ASCII numbers, set with the *F* command, any numbers returned as floats are returned as ASCII numbers. Each number is 7 ASCII characters: a sign, 3 digits, a decimal point and 2 more digits. If programming in C use `scanf("%7.2f", &value)` to read them.

**Binary**

In binary mode, set with the *f* command, the floats are sent as 4 byte IEEE 32-bit floats.

**Time Stamp 32 bit floating point number**

**ASCII**

In ASCII mode it is allowed 14 characters and is displayed as an integer (digits after the floating point are ignored).

**Binary**

In binary mode it is returned as a 32 bit float.

**Binary16 mode**

Set by selecting 18, 19 and/or 20 only with the *O* command. This is the fastest way to get data but the most difficult to decode and the least accurate.

**Example:**

For the default data record O1,2,4,1<> in ASCII mode 'F'. The output record set for the active stations 1 and 2 would look as follows:

```
'01  1.23  41.83  12.18  13.04  76.11  34.12CRLF'
'02  23.01 -452.94  0.01  -1.01  23.32  12.34CRLF'
```

For station 1: x=1.23,  y=41.83,  z=12.18,  yaw=13.04,  pitch=76.11 and  roll=34.12

For station 2: x=23.01,  y=-452.94,  z=0.01,  yaw=-1.01,  pitch=23.32 and  roll=12.34
System Status Record

This record is sent in response to the S command. It contains system wide status information. Some of the information in the status record must be bit decoded.

2IS{statusRecord}<>

Bytes Explanation
1 Record type, '2'
2 Station Number. Always '1'
3 Sub-Record type, 'S'
4 Config Hex Char 0
5 Config Hex Char 1
6 Config Hex Char 2
7-9 BIT error. Currently unused.
10-15 Blank
16-21 Firmware version ID
22-53 System Identification
54-55 CR, LF

To decode each of the Config bytes

Config Hex Char 0 Unused
Config Hex Char 1 Unused

Config Hex Char 2

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Output Format (0= ASCII, 1= Binary)</td>
</tr>
<tr>
<td>1</td>
<td>Output Units (0=Inches, 1= Centimeters)</td>
</tr>
<tr>
<td>2</td>
<td>Unused</td>
</tr>
<tr>
<td>3</td>
<td>Transmit Mode (0 = Polled, 1 = Continuous)</td>
</tr>
</tbody>
</table>

Output List Record

This record is sent in response to a O{stationNum}< command. It returns the list of currently selected output parameters for that station, 2 bytes per item.

2{stationNum}O{par1par2...parN}<>

Bytes Explanation
1 Record type, '2'
2 Station Number. A hexadecimal number up to C.
3 Sub-Record type, 'O'
4-5 par1
6-7 par2
... CR, LF

For example, the default data list would be returned as:
'21O 2 4 1<>'
**Station State Record**

This record is sent in response to a \( l\{\text{stationNum}\}<> \) command. If the \( \text{stationNum} \) parameter is omitted the record returns the state of the first four stations. This maintains compatibility with the Fastrak™ protocol. If \( \text{stationNum} \) is stated then byte 4 of the record will contain the state of the requested station. Bytes 5, 6, and 7 will contain the state of stations 2, 3, and 4. If \( \text{stationNum} \) is replaced with the ‘*’ wild-card character, then status for 32 stations is returned in a single record.

Output of values are interpreted as 1 for ON and 0 for OFF.

\[
2\{\text{stationNum}\}l\{\text{stat1stat2stat3stat4}\}<> 
\]

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record type , ‘2’</td>
</tr>
<tr>
<td>2</td>
<td>Station Number. 1, 2, 3, 4</td>
</tr>
<tr>
<td>3</td>
<td>Sub-Record type, ‘l’</td>
</tr>
<tr>
<td>4</td>
<td>State of station ( \text{stationNum} ), or station 1 if omitted.</td>
</tr>
<tr>
<td>5</td>
<td>State of station 2.</td>
</tr>
<tr>
<td>6</td>
<td>State of station 3.</td>
</tr>
<tr>
<td>7</td>
<td>State of station 4.</td>
</tr>
<tr>
<td>8-35</td>
<td>(if ‘*’) Status of stations 5 to 32.</td>
</tr>
<tr>
<td>8,9</td>
<td>or 36,37 CR, LF</td>
</tr>
</tbody>
</table>

For example, if stations 1 and 3 are on:

\( l1<> \) command will return ‘21111010<>’

\( l*<> \) command will return ‘211110100000000000000000000000000<>’

**Alignment Reference Frame Record**

This record is sent in response to an \( A\{\text{stationNum}\}<> \) command. It returns 9 ASCII floats that were last set with the \( A \) command. Each float is represented as 7 characters with 2 digits after the floating point.

\[
2\{\text{stationNum}\}A\{OxOyOzXxXyXzYxYyYz\}<> 
\]

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record type , ‘2’</td>
</tr>
<tr>
<td>2</td>
<td>Station Number. A hexadecimal number up to C.</td>
</tr>
<tr>
<td>3</td>
<td>Sub-Record type, ‘A’</td>
</tr>
<tr>
<td>4-24</td>
<td>( OxOyOz ) - origin coordinates</td>
</tr>
<tr>
<td>25-45</td>
<td>( XxXyXz ) - vector in the direction of the positive x axis</td>
</tr>
<tr>
<td>46-66</td>
<td>( YxYyYz ) - vector in the direction of the positive y axis</td>
</tr>
<tr>
<td>67-68</td>
<td>CR, LF</td>
</tr>
</tbody>
</table>
Boresight Reference Angles Record
This record is sent in response to a $G\{stationNum\}$ command. It returns 3 ASCII floats that were last set with the $G$ command. Each float is represented as 7 characters with 2 digits after the floating point.

$2\{stationNum\}G\{yawref\ \text{pitchref} \ \text{rollref}\}\langle\rangle$

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record type, '2'</td>
</tr>
<tr>
<td>2</td>
<td>Station Number. A hexadecimal number up to C.</td>
</tr>
<tr>
<td>3</td>
<td>Sub-Record type, 'G'</td>
</tr>
<tr>
<td>4-10</td>
<td>yawref - azimuth reference angle</td>
</tr>
<tr>
<td>11-17</td>
<td>pitchref - elevation reference angle</td>
</tr>
<tr>
<td>18-24</td>
<td>rollref - roll reference angle</td>
</tr>
<tr>
<td>25-26</td>
<td>CR, LF</td>
</tr>
</tbody>
</table>

Hemisphere Record
This record is sent in response to a $H\{stationNum\}\langle\rangle$ command. It returns 3 ASCII floats that were last set with the $H$ command. Each float is represented as 7 characters with 2 digits after the floating point.

$2\{stationNum\}H\{p1p2p3\}\langle\rangle$

Tip Offset Record
This record is sent in response to a $N\{stationNum\}\langle\rangle$ command. It returns 3 ASCII floats that were last set with the $N$ command. Each float is represented as 7 characters with 3 digits after the floating point.

$2\{stationNum\}N\{Ox\ \text{Oy} \ \text{Oz}\}\langle\rangle$

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record type , '2'</td>
</tr>
<tr>
<td>2</td>
<td>Station Number. A hexadecimal number up to C.</td>
</tr>
<tr>
<td>3</td>
<td>Sub-Record type, 'N'</td>
</tr>
<tr>
<td>4-11</td>
<td>Ox – X-direction tip offset</td>
</tr>
<tr>
<td>12-19</td>
<td>Oy – Y-direction tip offset</td>
</tr>
<tr>
<td>20-27</td>
<td>Oz – Z-direction tip offset</td>
</tr>
<tr>
<td>28-29</td>
<td>CR, LF</td>
</tr>
</tbody>
</table>
Position Operational Envelope Record

This record is sent in response to a $V\{stationNum\}<>$ command. It returns 6 ASCII floats that were last set with the $V$ command. Each float is represented as 7 characters with 2 digits after the floating point.

$2\{stationNum\}V\{Xmax,Ymax,Zmax,Xmin,Ymin,Zmin\}<>$

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record type , '2'</td>
</tr>
<tr>
<td>2</td>
<td>Station Number. A hexadecimal number up to C.</td>
</tr>
<tr>
<td>3</td>
<td>Sub-Record type, 'V'</td>
</tr>
<tr>
<td>4-11</td>
<td>$Xmax$ – Maximum X-direction value</td>
</tr>
<tr>
<td>12-19</td>
<td>$Ymax$ – Maximum Y-direction value</td>
</tr>
<tr>
<td>20-27</td>
<td>$Zmax$ – Maximum Z-direction value</td>
</tr>
<tr>
<td>28-35</td>
<td>$Xmin$ – Minimum X-direction value</td>
</tr>
<tr>
<td>36-43</td>
<td>$Ymin$ – Minimum Y-direction value</td>
</tr>
<tr>
<td>44-51</td>
<td>$Zmin$ – Minimum Z-direction value</td>
</tr>
<tr>
<td>52-53</td>
<td>CR, LF</td>
</tr>
</tbody>
</table>
10.5.4 InterSense-specific Records

Manufacturer System Status Record
This record is sent in response to an MS<> command. It returns a status record specific to the InterSense system.

31S{statusRecord}<>

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record type, '3'</td>
</tr>
<tr>
<td>2</td>
<td>Station number. Always '1'</td>
</tr>
<tr>
<td>3</td>
<td>Sub-Record type, 'S'</td>
</tr>
<tr>
<td>4</td>
<td>Config Hex Char 0</td>
</tr>
<tr>
<td>5</td>
<td>Config Hex Char 1</td>
</tr>
<tr>
<td>6</td>
<td>Config Hex Char 2</td>
</tr>
<tr>
<td>7,8</td>
<td>CR, LF</td>
</tr>
</tbody>
</table>

To decode each of the Config Hex Characters

Config Hex Char 0 Reserved
Config Hex Char 1 Reserved
Config Hex Char 2

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Reserved</td>
</tr>
<tr>
<td>1</td>
<td>Boresight Compatibility Mode (0 = Firmware Version 2.x, 1 = FASTRACK™)</td>
</tr>
<tr>
<td>2</td>
<td>Time units (0 = milliseconds, 1 = microseconds)</td>
</tr>
<tr>
<td>3</td>
<td>ReceiverPod LEDs (0 = OFF, 1 = ON)</td>
</tr>
</tbody>
</table>

Manufacturer Station Record
This record is sent in response to the Ms{stationNum}<> command. It returns a station status record specific to the InterSense system.

3{stationNum}s{statusRecord}<>

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record type, '3'</td>
</tr>
<tr>
<td>2</td>
<td>Station number. A hexadecimal number up to C.</td>
</tr>
<tr>
<td>3</td>
<td>Sub-Record type, 's'</td>
</tr>
<tr>
<td>4</td>
<td>Config Byte 0</td>
</tr>
<tr>
<td>5</td>
<td>Config Byte 1</td>
</tr>
<tr>
<td>6</td>
<td>Config Byte 2</td>
</tr>
<tr>
<td>7,8</td>
<td>CR, LF</td>
</tr>
</tbody>
</table>

To decode each of the Config bytes
Config Byte 0 Unused

Config Byte 1 Corresponds to the Perceptual Enhancement Level. Can be 0, 1, or 2. The remaining 2 bits are reserved for future expansion of this option.

Config Byte 2

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Reserved</td>
</tr>
<tr>
<td>1</td>
<td>Heading Compensation Mode bit 1</td>
</tr>
<tr>
<td>2</td>
<td>Heading Compensation Mode bit 2</td>
</tr>
<tr>
<td>3</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

Heading compensation bits are translated as:
- 00 – Compass mode 0 (compass is off)
- 01 – Compass mode 1 (Partial compass mode)
- 10 – Compass mode 2 (Full compass mode)

**Prediction Interval Record**

This record is sent in response to \texttt{Mp\{stationNum\}\(<\)}> command. It returns an ASCII integer for the number of milliseconds of prediction.

\texttt{3\{stationNum\}p\{interval\}\(<\)}

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record type, '3'</td>
</tr>
<tr>
<td>2</td>
<td>Station Number. A hexadecimal number up to C.</td>
</tr>
<tr>
<td>3</td>
<td>Sub-Record type, 'p'</td>
</tr>
<tr>
<td>4-5</td>
<td>Prediction interval.</td>
</tr>
<tr>
<td>6,7</td>
<td>CR, LF</td>
</tr>
</tbody>
</table>

**Sensitivity Level Record**

This record is sent in response to \texttt{MQ\{station number\}\(<\)> command. It returns the current sensitivity settings of a station. This setting is only relevant when Perceptual Enhancement level is set to 1 or 2.

\texttt{3\{Station Number\}Q\{Sensitivity Level\}\(<\)}

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record type, '3'</td>
</tr>
<tr>
<td>2</td>
<td>Station Number. A hexadecimal number up to C.</td>
</tr>
<tr>
<td>3</td>
<td>Sub-Record type, 'Q'</td>
</tr>
<tr>
<td>4</td>
<td>Sensitivity level 1 to 5</td>
</tr>
<tr>
<td>5,6</td>
<td>CR, LF</td>
</tr>
</tbody>
</table>
Genlock Synchronization Record

This record is sent in response to $MG<>$ command. It returns the current synchronization settings of the system.

$31G\{\text{State}\}, \{\text{Rate}\}, \{\text{Number of cycles per signal}\}<>$

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record type, ‘3’</td>
</tr>
<tr>
<td>2</td>
<td>Always 1.</td>
</tr>
<tr>
<td>3-11</td>
<td>Strobe rate or Output record rate</td>
</tr>
<tr>
<td>12-14</td>
<td>Number of computational cycles tracker performs between sync signals or output records. Multiply this parameter by Rate to determine the internal update rate of the tracker.</td>
</tr>
<tr>
<td>15,16</td>
<td>CR, LF</td>
</tr>
</tbody>
</table>
11 Appendix F – Care and Maintenance

Care and Cleaning

Recommended cleaning materials are the same as those for computers. Antistatic cloths can clean the components and reduce static electricity. Cleaning solutions should be applied to the cloth and not directly on any part of the system components.

Phone & email support

Any questions regarding the care and maintenance of your InertiaCube3 can be handled by phone (781) 541-7624 or by email techsupport@intersense.com. Please visit the InterSense support page at www.intersense.com/support for information about obtaining technical support.

Returns to InterSense

If you need to return a component to InterSense for replacement or repair, contact InterSense prior to shipment to obtain a Return Authorization (RA) number. When calling, please look on the back of IS-900 Processor to provide the serial number and the serial number of any devices you need to return to help us complete the RA process. To request an RMA please use the link below and follow the instructions:

http://www.intersense.com/rma

Please note that InterSense will not be responsible for materials returned without an RMA number clearly marked on the outside of the shipping package.

Batteries

There are no batteries in the InertiaCube3 system. The Wireless InertiaCube3 ships with a standard alkaline 9 VDC battery.

Electrical power

6 VDC, 40 mA for an InertiaCube3
6 VDC, 400 mA for the IC3 Processor with one InertiaCube3
6 VDC, 440 mA for the IC3 Processor with two InertiaCube3s